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Important Notice

The Sapphire Infusion Pump Service Manual is delivered subject to the
conditions and restrictions listed in this section. Qualified service technicians
should read the entire Service Manual, in addition to the Sapphire User
Manual, prior to operating the pump, in order to fully understand the
functionality and operating procedures of the pump and its
accessories.Service technicians and healthcare professionals should not
disclose to the patient the pump's security codes, Lock Levels, or any other
information that may allow the patient access to all programming and
operating functions.

Improper programming may cause injury to the patient.

Prescription Notice

Federal United States law restricts this device for sale by or on the order of a
physician only {21 CFR 801.109(b) (1)}.

The Sapphire infusion pump is for use at the direction of, or under the
supervision of, licensed physicians and/or licensed healthcare professionals
who are trained in the use of the pump and in the administration of
medication and parenteral nutrition. The instructions for use presented in this
guide should in no way supersede established medical protocol concerning
patient care.

Copyright, Trademark and Patent Information

© 2020, Q Core Medical Ltd. All right reserved.

Sapphire and Q Core (with or without logos) are trademarks of Q Core
Medical Ltd.

The design, pumping mechanism and other features of the Sapphire pump
are protected under one or more US and Foreign Patents.



Warning

Use only Q Core Medical Ltd. supplied administration sets and accessories
with Q Core infusion pumps. Use of administration sets other than Q Core
Medical Ltd. supplied sets may impair the operation of the pump and the
accuracy and flow rate of the infusion, and may generate hazardous fluid
pressures which may activate occlusion alarms at unpredictable pressures.

Q Core Medical Ltd.’s warranty on this device will be null and void and Q Core
Medical Ltd. will assume no responsibility for incidents which may occur if the
product is not used in accordance with product labeling.

Alternatively, administration sets from different manufacturers that are
regulatory cleared and labeled for use with the Sapphire infusion system, can
be used as well. The list of regulatory cleared sets needs to be obtained from
the official manufacturer's publication such as manufacturer's website, catalog
or any other formally published document.

Using anything other than administration sets regulatory cleared and labeled
for use with Sapphire infusion system, may result in operation that is not within
the constraints and parameters of the device.

o The use of Administration sets manufactured by ICU Medical
is approved for sale through March, 2023.

Technical Assistance

For technical questions, troubleshooting assistance and device problems,
please contact your local agent/distributor, and refer to page 268. You may
also contact Q Core Medical Ltd. support via email to the following address:
service@qcore.com.

Registered technicians can submit a call via the personal profile drop down
menu in the Service Portal at the following address

https://service.qcore.com/Main.aspx.
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Chapter 1: Introduction

This Sapphire Infusion Pump Service Manual is a Level 1 support service
manual that includes the technical information of all the available Sapphire
pumps: Sapphire Multi-therapy, Sapphire Epidural, SapphireH100 and
SapphirePlus. It is designed to assist trained technicians and support
personnel to perform the service functions appropriate to their level of
authorization.

A trained technician is a technician trained to complete maintenance actions
according the Q Core Training Standard Operating Procedure.

The following sections describe the structure of the Service Manual, and
provide a summary of safety information:

Manual Outline and CoNVENLIONS ......iviieeiiiiie e eeees 11
Compliance and Classification ..........coeiviiiiiiiiiniiiiiieei e 15
Terms and Abbreviations .......co.oviiiiiiriiiii e 12
Warnings and Safety Precautions ..........c.evviieiriiiiieeiiie e 18
FTP S wetiereeiieiiiee ettt e e ettt e e e et ettt e e e e e ee et e e e e eetb e e e eaaaaaaaees 32
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Manual Outline and Conventions

This manual describes the configuration settings available for trained
technicians and explains the procedures involved in servicing Sapphire pumps
(Sapphire Multi Therapy, Sapphire Epidural, ShapphireH100 and
SapphirePlus). The material provided in this manual supplements the material
detailed in the Sapphire User Manual. It assumes familiarity with the
information contained in the User Manual. Q Core Medical is not responsible
for any action performed by users that is not described in the Service Manual

or in its Addendum.

Before performing tasks or providing level 1 service support

to the Sapphire pump, read and become familiar with the

material in both the User Manual and the Service Manual.

This Service Manual is organized into the following chapters:

Chapter Description

Common chapters for all Sapphire infusion pumps

Introduction

Managing Authorization
Levels

Maintenance and Storage

Performing Annual
Certification Testing

Replacing the Battery

The scope of the current manual and its target
audience.

The procedures for assigning authorization levels in
the Sapphire pump, WiFi settings, WiFi
configuration using the SXManager Software and
testing the hard keys.

The proper cleaning, preventive maintenance, and
storage procedures for the pump and the battery.

The annual certification testing process for the
Sapphire pump.
How to replace the battery in the Sapphire pump.

Sapphire and SapphireH100

Configuring Basic Pump
Settings

Using Technician Options

11

How to view and update basic pump configuration
settings, using the Options menu.

The configuration options available to users with a
Technician authorization level code.
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Chapter Description

Alarms and Troubleshooting  The different types of alarms and messages that
can be generated by the pump, and explanation
on how to troubleshoot common programming
issues.

Upgrading Software Version ~ How to upgrade the pump software version.

SapphirePlus

Configuring Basic Pump How to view and update basic pump configuration
Settings settings, using the Options menu.

Using Technician Options The configuration options available to users with a
Technician authorization level code.

Alarms and Troubleshooting  The different types of alarms and messages that
can be generated by the pump, and explanation
on how to troubleshoot common programming
issues.

Upgrading Software Version ~ How to upgrade the pump software version.

To obtain information about features or procedures not included in this
manual, contact Q Core Medical by sending an email to the following
address: service@qcore.com, or a local distributor. For more information refer
to page 268.

Terms and Abbreviations

The following table defines common terms and abbreviations used in this
manual.

Term/Abbreviation Meaning

AC/DC Alternating Current / Direct Current
ACT Annual Certification Test

AFFV Anti-Free-Flow-Valve

BOH Bill Of Health
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Term/Abbreviation Meaning

BPOC Barcode Point-Of-Care

CCA Clinical Care Area

DFU Directions for Use

ECG Electrocardiogram

eMAR Electronic Medication Administration Record
EMC Electromagnetic compatibility

EMI Electromagnetic interference
FasTest PM FasTest Preventive Maintenance
FCC Federal Communications Commission
H Hour

HIS Hospital Information System

Kg Kilograms

KvO Keep Vein Open

LE-LAN License-Exempt Local Area Network
M Units Million Units

MAC Media Access Control

mcg Micrograms

mEq Milliequivalents

mg Milligrams

min Minutes

mL Milliliters

mmol Millimoles

mUnits Milliunits

nanog Nanograms

Occ. Occlusion

PAV Pressure Activated Valve

PDA Personal Digital Assistant

PHY Physical Layer

Q Core Q Core Medical Ltd.
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Term/Abbreviation Meaning

QoS Quality of Service

RF Radio Frequency

Sapphire pump Q Core Sapphire infusion pump family
Service Portal Q Core Medical Service Portal

SCM Sapphire Configuration Manager

TPN Total Parenteral Nutrition

VI Volume Infused

VTBI Volume To Be Infused

WLAN Wireless Local Area Network

Document Conventions

The following messages in this manual prompt readers to pay special
attention to specific points:

Warnings indicate precautions and instructions which, if not
A followed, may result in personal injury.

Cautions indicate instructions which, if not followed, may
&5 result in damage to the equipment. Cautions are also used
to advise against unsafe practices.

o Notes provide additional information to help obtain optimal
equipment performance.

Introduction
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Compliance and Classification

This manual has been written in conjunction with the requirements in the
International Standard, IEC 60601-2-24 for Medical Electrical Equipment -
Part 2-24: Particular Requirements for Safety of Infusion Pumps and
Controllers. Data presented in the Technical Specification section reflect
specific test conditions defined in this standard.

Other external factors, such as varying back pressure, temperature, head
height, set usage, fluid restrictions, solution viscosity, or combinations of
these factors may result in deviations from the performance data presented.
* [EC 60601-1, UL 60601-1 and CAN/CSA C22.2 601.1-M90 medical

electrical equipment, which classifies the Sapphire pump as:

* Class|l

® Type BF

® Continuous operation

® P24 dust and splash proof

* Not suitable for use in the presence of flammable anesthetic mixture

with air or with oxygen or nitrous oxide

e |EC 60601-1-2: Electromagnetic compatibility.

® |EC 60601-1-12 - Requirements for medical electrical equipment and
medical electrical systems intended for use in the emergency medical
services environment.

* |EC 60601-2-24: Infusion pumps and controllers, which classifies the
Sapphire pump as a Type 4 pump (continuous infusion flow, combined
with bolus delivery).

® |EC 60601-1-11: Requirements for medical electrical equipment and
medical electrical systems used in the home healthcare environment.

* |EC 60601-1-8: Requirements for alarm systems in medical electrical
equipment and medical electrical systems.

®  Defibrillator compliance statement: Equipment Type BF Applied Part.

* |EEE 802.11 a/b/g/n: Requirements for wireless local area network
(WLAN) computer communication — synonymous with WiFi.

® FCC: The Federal Communications Commission (FCC) regulates
interstate and international communications by radio, television, wire,

satellite and cable. The Sapphire pump complies with Part 15B, 15C, 15E
of the FCC Rules.

15 Sapphire Infusion Pump Service Manual



Wireless Communication

The SapphirePlus pump contains a Connectivity Module that allows for
implementing Wireless Local Area Network (WLAN) networking capabilities.
This allows the application software to download drug libraries and software
updates to the infusion pump and enable the auto-programming feature over
a wireless connection.

The pump’s WiFi abilities have been tested and approved according to United
States rules and regulations. Using the pump’s WiFi abilities outside of the
United States where allocations and technical parameters may be different,
may result in the violation of government regulations and possibly affect the
functionality of the WiFi module.

FCC Information

US FCC (FEDERAL COMMUNICATIONS COMMISSION) STATEMENT

The Federal Communications Commission (FCC) regulates interstate and
international communications by radio, television, wire, satellite and cable.
The Sapphire pump complies with Part 15B, 15C, 15E of the FCC Rules.
Operation is subject to the following two conditions:

1. This device may not cause interference.

2. Pump operation must not be affected by any transmitted interference
from other devices.

FCC INTERFERENCE STATEMENT

This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15B, 15C, 15E of the FCC Rules. These
limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and
can radiate radio frequency energy. If not installed and used in accordance
with the instructions, it may cause harmful interference to radio
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communications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try and correct
the interference by one or more of the following measures:

® Reorient or relocate the receiving antenna.

® Increase the distance between the equipment and the receiver.

® Connect the equipment to an outlet on a circuit other than the one to
which the receiver is connected.

®  Consult the dealer or an experienced radio/TV technician for help.

RADIO FREQUENCY EXPOSURE STATEMENT

® The Wireless LAN radio device in the connectivity module peripheral

board of this infusion device has been evaluated and found compliant to

the requirements of the following Radio Frequency exposure standards:

® Federal Communications Commission, OET Bulletin 65 (Edition
97-01), Supplement C (Edition 01-01), Evaluating Compliance with
FCC Guidelines for Human Exposure to Radio frequency
Electromagnetic Fields, July 2001.

* EN 50360 and EN62311

®  The radiated output power of this Wireless device is far below the FCC
radio frequency exposure limits. The Wireless Sapphire device has been
evaluated at 0.2 inches away from a human body, and found to be
compliant with FCC RF exposure limits.

Biocompatibility

All materials in components of the administration sets that are in the fluid
pathway have been tested for biocompatibility, and are in compliance with
applicable international standards ISO 10993-1 for biocompatibility.
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Sterilization

Administration sets that are manufactured by Q Core for the Sapphire pump,
are sterilized with ethylene oxide (EO), according to the sterilization
requirements of ISO 11135.

Degree of Protection Against Ingress of Water and Dust

The Sapphire pump meets the IP24 splash/dust standard according to IEC
60601-1-11. Protects from water which is sprayed at 10L/min at a pressure of
80-100kN/m2 for 5 minutes at all angles, and protects from touch by objects
greater than 12 millimeters such as fingers.

Warnings and Safety Precautions

The following sections contain important safety information.

All warnings and safety precautions should be read carefully before operating
the Sapphire pump:

®  General Warnings and Precautions on page 18

®  Proper Use of the Pump on page 23

Safety information specific to particular pump functions appears in the
relevant sections of this manual.

General Warnings and Precautions

To ensure safety and proper operation, read the User Manual and any
instructions accompanying disposables or accessories before operating this
device. In addition, adhere to the following safety guidelines:

Avoid placing the administration set or power cord on the

A floor, or any other location where it can accidentally be
damaged or provide a risk of strangulation, particularly due
to excessive length.
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* To avoid damage to the pump and its accessories, keep the equipment
away from unattended children and pets.

* Do not clean, disinfect or sterilize any part of the pump by autoclaving, or

with ethylene oxide gas. Doing so may damage the pump and void the
warranty. Only external parts of the pump should be disinfected.

A If the pump is dropped or appears to be damaged, it should
be taken out of service and inspected by Q Core Medical
Ltd. trained, qualified personnel only.

* Do not operate the pump with the safety door open.

Waste Disposal

Make sure to dispose of the packaging, the administration sets, the battery,
and any other electronic components in accordance with applicable
environmental laws (such as the WEEE Directive for Waste Electrical and
Electronic Equipment). Contact your local authority to determine the proper
method of disposal.

A Waste Disposal Safety Precautions

* Keep used plastic reservoir container, packaging and tubing out of the
reach of children.

® Administration sets should be disposed of in a proper manner,
considering the nature of residual fluid that may be contained within, in
accordance with hospital disposal practices.

* Do not dispose of the battery in or near fire.

Explosion Hazard

The equipment is not suitable for use in the presence of flammable anesthetic
mixture with air or with oxygen or nitrous oxide.
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Electric Shock Hazards

To promote safety, always adhere to the warnings listed below.

A Electrical Safety Precautions

®  Access to any internal part of the Sapphire pump and the performance of
any service procedures should be carried out only by a qualified service
technician, fully trained in the operation of the infusion pump.

® Disconnect the power supply before servicing.

® Disconnect the battery prior to opening the pump casing. Voltage
present on internal components may cause severe shock or death on
contact.

® Connect AC power to the pump only via a Q Core supplied power
adapter.

® Do not touch the pump to cradle (P2C) connection in the back on the
pump.

Electromagnetic Compatibility

The Sapphire pump is designed to conform with electromagnetic
compatibility (EMC) standard IEC 60601-1-2 and to operate accurately in
conjunction with other medical equipment which also meets the requirements
of this standard. To avoid electromagnetic interference that may affect the
operation of the pump, do not use the pump near sources of strong electric
and magnetic interference (EMI), such as MRI, CT, diathermy (deep heat
treatment), electromagnetic security systems (e.g. metal detectors) and large
electric motors.

Portable and mobile RF communications equipment, such as RF emitters,
cellular telephones, 2-way radios, Bluetooth™ devices, microwave ovens in
close proximity to this device may affect wireless communications with the
Infusion pump and/or the operation of the Infusion pump.

Some of these EMI sources (mostly RF emitters) may not be visible and the
device can potentially be exposed to fields from these EMI sources without
the user's awareness.

Special precautions need to be exercised regarding EMC. These include:
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Maintaining a minimum separation distance of 2 ¥z ft (% m) between the
Infusion pump system and portable/mobile RF communications
equipment

Manage the electromagnetic environment to permit the device to
perform as intended without disturbing other equipment.

Separate the device from all other electronic equipment. If the device
must be used near other electrical equipment, monitor the equipment to
ensure there is no electromagnetic interference.

Devices should not be used adjacent to or stacked with other equipment.
If the device must be used adjacent to or stacked with other equipment,
monitor the device to verify normal operation.

If you identify or suspect external RF sources or other equipment are
influencing device operation (from known or unknown source), try to (as
applicable) increase the pump's distance from the EMI source, re-orient
the device, relocate the device, connecting device to different outlet,
contact the biomedical engineering department for additional guidelines
concerning electromagnetic immunity or decrease emitting device
output power (to 30 dBm).

Contact the biomedical engineering department for additional

information in the service manual concerning operating devices near RF
sources.

The EMC limits for the Medical Device Directive 93/42/EEC (EN301489-1/-17
IEC/EN 60601-1-2:2007) are designed to provide reasonable protection
against harmful interference in a typical medical installation. The equipment
generates uses and can radiate radio frequency energy, and if not installed
and used in accordance with the instructions, may cause harmful interference
to other devices in the vicinity. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does
cause harmful interference with other devices, which can be determined by
turning the equipment Off and On, the user is encouraged to try to correct
the interference by one or more of the following measures:

21

Reorient or relocate the receiving device
Increase the distance separating between the equipment parts

Connect the equipment to an outlet on a circuit different from that to
which the other device(s) is connected

Consult the manufacturer or field service technician for help
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Electromagnetic Safety Precautions

* Do not expose the pump to therapeutic levels of ionizing radiation, as
permanent damage to the pump’s electronic circuitry may occur. It is
preferable to remove the pump from the patient during therapeutic
radiation sessions.

® Do not use the pump in the vicinity of magnetic resonance imaging (MRI)
equipment, as magnetic fields may adversely affect the operation of the
pump. Remove the pump from the patient during MRI procedures, and
keep it at a safe distance from magnetic energy.

Wireless Compatibility

To promote safety, always adhere to the precautions listed below.

Wireless Device Precautions

®  The wireless 802.11a/b/g/n device usage in the 5150-5250 MHz band is
limited to indoor use to reduce potential for harmful interference to
co-channel mobile satellite systems.

® Inthe 5250-5350 MHz and 5650-5850 MHz frequency bands, high power
radars are allocated as primary users and these radars could cause
interference and/or damage to LE-LAN devices.

®  Operation is subject to the following two conditions: (1) the wireless
device may not cause interference, and (2) Pump operation must not be
affected by any transmitted interference from other devices.

Data Transfer and Integrity

The SapphirePlus pump wireless system is capable of operating at a full
bandwidth of 802.11 a/b/g/n.

For network planning purposes, each pump transfers no more than 10 KB/min
(kilobyte per minute).

Data integrity is achieved in two levels:
® By WiFi TCP/IP protocol
® By the software of the pump
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Wireless Quality of Service

Quality of Service is primarily the responsibility of the network and the
networking equipment. It may be achieved by improving several network
aspects:

®  Use networking devices that support QoS infrastructure.

® Use a dual-band access point so that if one of the bands is too crowded,
the second band can be used. This is supported by the Sapphire WiFi
module.

®  Use roaming to ensure that the WiFi device will be assigned to the access
point where the radio signal received from the pump is the strongest one.

The level of cyber security is the responsibility of the network
administrator and based on the network configuration.

Proper Use of the Pump

Although the Sapphire pump has been designed and manufactured to
exacting specifications, it is not intended to replace trained personnel in the
monitoring of infusions.

A Home users must be trained by their medical provider before
using the Sapphire pump.

g Clinicians are advised to verify the proper route of delivery,
and the patency of the infusion site.
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When using the pump, periodic patient monitoring must be performed to
ensure that the infusion is proceeding as expected. The pump is capable of
developing positive fluid pressures to overcome widely varying resistances to
flow, such as resistance imposed by small-gauge catheters, filters, or
intra-arterial infusions. Although the pump is designed to stop fluid flow when
an alarm occurs, it is neither designed nor intended to detect infiltrations, and
will not alarm under infiltration conditions.

A When using the pump, use only Q Core's approved
accessory equipment.

g If auditory and/or visual signals do not perform according to
settings, or if the hard keys do not perform as expected, do
not use the pump, and contact a trained technician.

Environmental Safety Precautions

® The pump has not been evaluated for use within magnetic resonance
imaging (MRI) environments, or with other medical equipment that emits
radiation for diagnostic or therapeutic purposes.

® The Sapphire pump has not been evaluated for compatibility with
Extracorporeal Membrane Oxygenation (ECMO) systems.

® The use of accessories and cables other than those specified in this
manual, with the exception of cables sold by Q Core Medical Ltd. as
replacement parts for internal components, may result in increased
emission or decreased immunity of the pump.

Administration Sets

Before using administration sets, always read and follow the instructions in the
User Manual, and the instructions accompanying the administration set and
source container. Carefully follow any label copy instructions for loading,
removing, and reloading the set, as well as the recommended set change
interval.
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Use Q Core standard administration sets listed in Q Core's approved list of
products: http://www.qcore.com/. Alternatively, administration sets from
different manufacturers that are regulatory cleared and labeled for use with
the Sapphire infusion system, can be used as well. The list of regulatory
cleared sets needs to be obtained from the official manufacturer's publication
such as manufacturer's website, catalog or any other formally published
document.

Using anything other than administration sets regulatory cleared and labeled
for use with Sapphire infusion system, may result in operation that is not within
the constraints and parameters of the device. Severe injury or death may
result from using sets other than those indicated in Q Core's approved list of
products. For more information refer to Administration Sets on User Manual,
15025-048-0095 page 63.

o The use of Administration sets manufactured by ICU Medical
is approved for sale through March, 2023.

For infection control purposes, consider the set change interval
recommended by the local Centers for Disease Control and Prevention (CDC),
your facility’s guidelines, and the instructions provided with the administration
set.

A Administration Sets: Safety Precautions

® Do not use a damaged administration set or damaged set components or
packaging. Always refer to the instructions for use that are included.

® Q Core administration sets are for single patient use only, and should
not be sterilized or cleaned for re-use.

® Do not connect the administration set to the patient while priming.
* Do not use force when connecting the administration set to the patient.

® Always use the clamps on the administration set to occlude the
administration set prior to removing the Q Core administration cassette
from the pump.

® Do not apply pressure or pressurized air to any outlet or tubing
connected to the pump. Pressure may destroy sensitive elements.
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* Do not pull or stretch the tubing in any section of the administration set
when the pump is in use, nor apply pressure to the reservoir container.

A The minimum pull force applied on the administration set
which is capable of disengaging the administration set from
the pump is 2.855 Kg.

®  The administration set and container should be replaced as needed to
avoid fluid contamination problems.

®  The administration set must be replaced according to the hospital policy
of infection control and treatment protocol. Q Core’s sets allow accurate
delivery up to 96 hours. If you program rate, dose or bolus combinations
which exceed a 96-hour schedule, make sure that you replace the
administration set on time.

Basic Infusion Safety Information

To obtain maximum accuracy of the pump when used in a hospital or clinical
environment, verify that the infusion container is positioned at a height of 50
cm above the pump. There is no restriction on the location of the infusion
container in relation to the patient's heart.

Alarm conditions automatically stop the infusion and require immediate
attention before the infusion can be restarted. When clamping the
administration set, ensure the clamp is at least 20 cm (8 in) away from the
pump, when possible. Note that if the dose rate is beyond the pump
resolution of 0.1mL/h increments, the pump will increase or decrease the rate
by up to 0.05mL/h. This flow rate (mL/h) is presented on the running screen
during infusion.

A Administering Infusions: General Safety Precautions

®  Air detection (in software versions that support the disabling of Air
detection):
* Air detection is an important safety feature of the Sapphire pump. If
the air detection is disabled (Off), use a set with an air-eliminating filter
to prevent injury to the patient due to an air embolus.
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® Air detection serves as a safety component. Disabling the air
detection hinders the pump's ability to alert on hazardous situations.

® Always ensure that the administration set is primed before starting an
infusion.

® The air detector working range when delivering fatty acids is 2%-20%
lipids.

®  Occlusion Pressure Alarm Settings:

* High pressure settings may affect the time for occlusion detection.
Make sure to set the occlusion pressure according to the clinical use
case.

® When using sets with a Pressure Activated Valve (PAV), detection may
be offset by 0.3 BAR (4.35 PSI or 225 mmHg).

®  Volume To Be Infused: Do not enter a value greater than the amount of
fluid available in the container.

® Secondary Infusions: When using the Piggyback infusion feature, verify
that:

® the medication/solution in the Secondary reservoir container is
compatible with the medication/solution in the Primary reservoir
container.

® the Secondary administration set is connected to the appropriate
injection site on the primary administration set.

* interruption of the Primary infusion is clinically appropriate for the
duration of the Piggyback infusion.

® the Secondary source container is positioned at least 8 inches (20 cm)
higher than the Primary source fluid level.

® the drip chamber on the set should be used to verify that the correct
line is delivering and the other line is idle.

* the clamp of the Secondary tubing is closed when Piggyback infusions
are not running.

The following sections contain important safety information. All warnings and
safety precautions should be read carefully before servicing the Sapphire

pump.
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A When working with the Sapphire pump, always adhere to the following

instructions and safety guidelines:

This equipment is not suitable for use in the presence of a flammable
anesthetic mixture with air, oxygen, or nitrous oxide.

The pump uses a Li-lon battery, supplied by Q Core. Replace the battery
only with the same type (Q Core issued battery). An explosion hazard
exists if the battery is replaced by an incorrect type or not according to
the instructions. For more information refer to Replacing the Battery on
page 154.

Do not short circuit the battery terminals. Do not disassemble or modify
battery packs.

Do not dispose of batteries or battery packs in fire.

The packaging, the administration sets, the battery, and any other
electronic components must not be disposed of as unsorted municipal
waste, and must be collected separately in accordance with applicable
environmental laws (such as the WEEE Directive for Waste Electrical and
Electronic Equipment). Contact an authorized representative for
information concerning the decommissioning of your equipment.

Do not use a pump that has been dropped or that is visibly damaged.
The pump must be inspected and repaired by a qualified service
technician prior to further use.

Do not test the pump if the room temperature is not in range (room
temperature: 18° - 29° C).

Use only Q Core approved administration sets. Use of any other sets will

result in malfunction or inaccurate delivery. For a list of approved sets,
refer to the Sapphire User Manual.

n Authorization level codes are provided in Managing
Authorization Lock Levels on page 37. Do not leave this
manual near unauthorized personnel or patients.

g Do not disclose the passwords of authorization levels to
unauthorized users.
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When working with the pump, always adhere to the following

precautionary guidelines:

e Federal (USA) law restricts this device to sale by or on the order of a
physician or other licensed practitioner.

®  Operate the pump only on the AC line voltage for which the AC Power
Adaptor is marked.

®  While the pump is in storage, recharge the battery at least every 12
months.

® Before servicing the pump, disconnect it from the AC power source.

® Routine cleaning and periodic maintenance is necessary to ensure that

the pump remains safe and functional. For details, refer to Chapter 3:
Maintenance and Storage on page 42.

®  Solution spills should be wiped up as soon as possible, using a damp
cloth or sponge. Dry the pump thoroughly before use.

®  Static sensitive electronics used in the pump may be damaged by
electrostatic discharge. Service technicians must follow proper ESD
procedures when working on the pump.

* Do not use a pen or any other sharp object to press the hard keys or the
buttons on the touch screen. Replace torn or punctured front panel
immediately, to prevent damage to the front panel switch.
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Default Configuration Settings of the Sapphire Pump

Feature

Occlusion Units
Occlusion Threshold
Pump unattended
Infusion near end
Alarm Volume

Keys volume
Authorization level
Allow delayed start

Allow PreProgram
PreProgram

Set Prime Volume
Backlight

Prime Reminder
Bolus Handle

Language

US Format

Single Air detector
Accumulated Air detector
Accumulated Threshold
New Patient

Continuous Bolus Rate

Set Secondary
(continuous delivery)

PCA / PCEA infusion
type

Introduction

Default
BAR

0.4 BAR
10 minutes
10 minutes
Maximum
High

High

Off

Off

Off

20 mL
On
Off

Always On

English
Off

Off

0.05 mL
1 mL
Off

125 ml/h
Off

Continuous + Bolus

For Details Refer To

Configuring General Settings
Configuring General Settings
Configuring General Settings
Configuring General Settings
Configuring General Settings
Configuring General Settings
Configuring General Settings
Configuring General Settings

Sapphire & SapphireH100:

Configuring General Settings

SapphirePlus: Configuring
General Settings

Configuring General Settings
Configuring General Settings

SapphirePlus: Configuring
General Settings

SapphirePlus: Configuring Basic

Pump Settings

Configuring General Settings
Configuring General Settings
Using Technician Options
Using Technician Options
Using Technician Options
Using Technician Options
Using Technician Options

Using Technician Options

Sapphire & SapphireH100:

Using Technician Options



Feature Default For Details Refer To
Limit Period 1 Hr User Manual (Using Special
Mode Options).

The feature is available only in
the PCA/PCEA/Epi. Int
options menu

WiFi Off SapphirePlus: Using Technician
Options

Allow Loading Dose On User Manual (Using Special
Mode Options)

Auto.P.Lockout Off User Manual (Using Special

Mode Options)

Password request No User Manual (Using Special
Mode Options)

The specific parameters ranges are listed in 'Using the Infusion Modes'

chapter of the Sapphire User Manual.
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FTP site

Q Core FTP site contains the latest version of the pump software, Pump
Loader software, Annual Certification software, Event Log Viewer software,
BOH software, and user manuals.

o The files located at the FTP Site are highly confidential.
Keep your user name and password in a safe place and do not
allow your browser to save them automatically.

> To access Q Core FTP Site:

o ® Accessing the Q Core FTP site requires your browser to
access HTTPS://qcore.smartfile.com. HTTPS is an estab-
lished standard for secure, encrypted web-based commu-
nications and operates via TCP/IP port 443.

® |t is recommended to use Google Chrome.

1. Obtain username and password directly from Q Core Medical at

service@qcore.com, or a local distributor. For more information refer to
page 268.

2. Type https://qcore.smartfile.com in the browser address bar, and press
Enter.

3. Enter your username and password, and then click Login.
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Chapter 2: Managing Authorization

Levels

The following sections review the security passwords and levels of
authorization and explain how to view and change the current authorization
lock level:

OVEIVIBW ittt ettt et ettt ettt e et et e e et e e e e e eraeeeneenneens 34

Managing Authorization Lock LeVels ........cooueiiiiiiiiiiiiiiie e, 37

PasSSWOIA RE-ENEIY oueiiiiiiieeii et e e e aans 40
Overview

To help ensure patient safety, the Sapphire pump can be set to one of four
authorization levels. Authorization levels control access to the programming
options available in the pump. Each level enables users to access a different
set of pump actions and programming options.

Authorization levels are modular. Therefore, users with a given authorization

level can access actions available to their level, in addition to all actions

available to users with lower authorization levels. The levels are:

® Low: All programming options are disabled, and no settings can be
changed.

®  Medium: Basic programming options, such as using shortcuts to start
infusions, are enabled.

* High: All tasks and configuration settings are enabled, except for options
limited to technician use.

® Technician: All settings are enabled. This level is restricted to technicians
and developers only.

o Passwords are defined by a technician or loaded with the
Drug Library. For information regarding new security
passwords definition by a technician, refer to To change the
passwords: on page 180, or page 237.
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Specific actions allowed in each of the authorization levels are listed in the
following table.

Authorization Level Allowed Actions

Low Stop the pump, and then continue the infusion
Power the pump on and off
Administer patient bolus
Use the View menu

Activate immediate taper-down during TPN infusion, using
the taper-down period defined by the clinician

Medium Stop the pump, and then start an infusion
Start infusions using the PreSet Programs feature
Start infusions using the Repeat Last Infusion feature
Priming with the pump

Edit Rate during running infusion (the option must be
enabled prior to the infusion by an authorized Technician)

View bolus rate (PCA options)

Activate immediate taper-down during TPN infusion, and
set the time for it

Use the set delay feature
High Start infusions using the New Infusion feature
View/Edit parameters
Use the Pump Configuration menu
Create/Edit PreSet programs (requires a unique password)
Changing delivery mode (requires password re-entry)
Clinician bolus (requires password re-entry)
Use of all PCA, PCEA and PIEB options
Technician All
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When the pump is turned off, the authorization lock level setting is saved.
Therefore, the lock level set most recently is maintained when the pump is
turned back on.

o If the pump is turned off in Technician mode, the pump turns
back on in a High level authorization lock level.
Verify that the pump is not in Technician mode before
returning it to the user.

o It is recommended to change the authorization level
passwords from the factory defaults, to avoid unauthorized
users from accessing the pump. To change a password see
To change the passwords: on page 180.

The default passwords are:

Level Password

Low 9990
Medium 8880
High 7770

Technician 7772

g Do not publish or email codes to unauthorized people. Do
not give access of this publication to home users.
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Managing Authorization Lock Levels

View and change the current authorization lock level as required.

Viewing Authorization Lock Levels

The current authorization lock level can be viewed via the Options menu.
When an infusion is running, the lock level can be accessed via the Running
screen.

> To view the current authorization lock level from the Options
menu:

®  From the Options menu, select View = View system.

The Authorization level is displayed.

> To view the current authorization lock level via the Running
screen:

1. From the toolbar of the Running screen, press View/Edit.
2. From the View/Edit screen, select View system.

The Authorization level is displayed.

Setting Authorization Lock Levels

Users with an authorization level of High can reset the authorization lock level
of the pump.

> To change authorization level from a lock level of High:
1. From the Options menu, select Pump configuration - General settings.

2. Select Authorization level. Then, using the keypad, enter the High level
password = OK.

o Entering a Medium or Low level password generates an
error message.

The authorization level matching the entered password, as well as all
levels below it, are listed on the Main Display.
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3. Select the authorization level at which you want to lock the pump. Then,
from the Attention screen, press OK.

4. To exit the Options menu, press OK.
> To change authorization level from a lock level of Medium or Low:
1. From the Options menu, select Pump configuration.

2. On the Password screen, using the keypad, enter the High level
authorization password. Then, from the toolbar, press OK.

3. To exit the Options menu, press Exit.

g Do not disclose the passwords of authorization levels
Medium, High or Technician to patients, home users, or any
other unauthorized user.

Setting Technician Lock Level

Users with Technician authorization level have two options in setting the lock
level for the Sapphire pump. The procedures vary, depending on how the
pump is configured.

> If the pump is set on High or Technician lock level:

1. From the Options menu, select Pump Configuration = General
Settings.

Select Authorization Level.
From the keypad, enter the Technician or High Level password.
Press OK.

Select the authorization level at which to lock the pump.

ok w

The authorization level matching the entered password, as well as all
levels below it, are listed on the Main Display.

6. Press OK to confirm.
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/. Press OK to exit the Options menu.

> If the pump is set on Medium or Low lock level:

1. From the Options menu, select Pump Configuration.

2. From the keypad, enter the Technician or High Level password.
3. Press OK.

o The Sapphire pump allows you to override a lower
authorization level by entering the High level password
whenever a password request appears onscreen.
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Password Re-entry

The Sapphire pump is designed to prevent inadvertent parameter changes, or
actions other than those permitted by the currently set authorization level. As
a safety measure, the pump will prompt you to re-enter your High level
password before performing the following actions:

® Changing delivery mode
® Changing authorization level
® Programming a clinician bolus

o Entering a High level authorization password allows access
to these actions, even if the pump is set at a Medium or Low
authorization lockout level.

A password entry is also required to unlock the screen when the Auto Patient
Lockout feature is enabled. The authorization level of the password entered
sets the authorization lockout level of the pump.
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Chapter 3: Maintenance and Storage

This chapter describes the proper cleaning, preventive maintenance, and
storage procedures for the pump and the battery. It includes content from the
corresponding chapter in the Sapphire User Manual with relevant material
highlighted for trained technicians:

Cleaning and Disinfecting the PUMP ......coooiiiiiiiiiiiiiiii e, 43
Cleaning Electrical Connectors of Sapphire Accessories .........ccooeeevvveevvnnnnnns 47
Preventative MaintenanCe .........cooouiiiiiiiiiiiiie e 48
Battery Care INformation .......cc.eieriiiiiiiiei e 57
Splitter Assembly INSTrUCtIONS ....u.iiiiiiiiiie e 62
Sapphire Multi-Pump Mounting System .........coviiiiiiiiiiiiieceeeee e, 63
Integrated Power SUPPIY (IPS) oveeeieiiieiiiiiiiieeeeeee e e e e e e e e 71
Q Core Service for SApPhire PUMPS ....ovveiiiiiiiiereeiiiiiieeeeeeriiiee e eeeeiiineseeenne 81
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Cleaning and Disinfecting the Pump

Between use on different patients, the Sapphire pump and all of its
components need to be first cleaned, and then disinfected, per hospital/
medical provider protocol for multiple patient use.

Cleaning and disinfecting the pump involves wiping it with Dispatch®
(Caltech) ready-to-use towels.

o For cleaning, one minute waiting time.
For disinfecting, 15 minute waiting time.

Cleaning/Disinfecting Solution Manufacturer

Dispatch® (Caltech) ready-to-use towels Caltech

Virex® Il 256 Diversey

Virox® AHP 5 RTU Diversey

Klor DeTM (Chlorine tablets) Concept

70% Isopropyl alcohol Generic (any brand containing 70%

Isopropyl alcohol diluted in water)

/. Cleaning and Disinfection: Safety
Precautions

Before and during cleaning, adhere to the following safety guidelines and
recommendations:

®  Only people who are trained in the maintenance of this type of medical
device should clean the infusion pump.

® Before cleaning/disinfecting the pump, verify that:
® The pump is disconnected from the patient.
® The pump is disconnected from all connections, sets, and accessories.
® The pump is turned off.
® The pump is disconnected from a power supply.

43 Sapphire Infusion Pump Service Manual



While cleaning/disinfecting the pump, do not allow fluid to enter the
pump housing, speaker holes, or battery chamber.

Do not use aggressive cleaning agents - these can damage the exterior
surface of the pump.

Do not steam autoclave, ethylene oxide sterilize, or immerse any part of
the pump in fluid.

Do not use spray or aerosol cleaners.
Do not clean or disinfect the pump using liquid household Bleach, as
deterioration may occur.

Dispose of all cleaning/disinfectant materials per laws and regulations for
infectious waste disposal.

Before using materials other than the products listed above
for cleaning and disinfecting the Sapphire Infusion pump,
make sure they are listed in Q Core Medical’s official
approved list of materials (published at http://
www.qcore.com).

A The pump must be completely dried out before connecting
it to a power supply.

Cleaning and Disinfecting Procedure

Cleaning Procedure

The following procedure explains how to clean the pump using the approved
agents (listed above):

> To clean the pump:

1.

Turn the pump off and unplug the power cord from the pump power
socket.

Use the appropriate dilution ratio according to the manufacturer's
instructions.
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When the solution is ready, apply the solution on a cloth or sponge, then
squeeze so it won't drip.

Wipe the exterior planes areas in back and forth motions, vertically and
horizontally (mainly on the pump housing).

The wiping should be applied with normal force, few times on the same
locations (at least twice) verifying complete coverage of the areas to be
cleaned.

Guidelines for cleaning specific pump components are listed in the table
below.

After the cleaning process is completed, the pump should be dried out
for 10 minutes.

Wipe the pump with a clean dry cloth.

Disinfection Procedure

The following procedure explains how to disinfect the pump using the
approved agents (see Cleaning and Disinfecting Procedure on page 44):

> To disinfect the pump:

1.
2.

45

Perform steps 1-6 specified in the cleaning process above.

Replace the cloth or sponge with a new one and repeat steps 3-5
(specified in the cleaning process above) two more times (a total of 3
cycles).

After the disinfection process is completed, the pump should be dried
out for 15 minutes.

Wipe the pump with a clean dry cloth.

A Before using materials other than the products listed above
for cleaning and disinfecting the Sapphire Infusion pump,
make sure they are listed in Q Core Medical's official
approved list of materials (published at www.qcore.com)
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Guidelines for cleaning/disinfecting specific pump components

Guidelines for cleaning/disinfecting specific pump components are listed in
the following table.

Component Cleaning Recommendations

LCD Screen Wipe thoroughly with a squeezed sponge.
Avoid scratching the LCD panel. Ensure that
no fluid enters the speaker holes at the top of

the panel.

Sensor Finger Clean the finger tip of the sensor using only a
damp cloth or sponge.

® |nternal White Panel This part should be kept free from foreign

e Bubble Detector (on the materials and dirt. If necessary, use foam swab

moistened with the detergent solution to clean
the connector, particularly around the 4 fingers
roots by applying normal finger force, assuring
that the swab reaches all areas, at least twice.

internal white panel)

® Anchor (on the internal
white panel)

¢ Locking tooth (on the Note: Swabbing should be applied in vertical
internal white panel) or horizontal movement, where possible, while
® P to C connector, Power less accessible areas will be swabbed in a

communication connector  circular motion (at least 3 bi-directional
rotations clockwise-counterclockwise).

Do not return the Sapphire pump to the patient if it is
&R unclean or damaged.

Reprocessing the pump when used by a single patient multiple
times
When the Sapphire pump is used by a single patient for multiple times, the

pump and all of its components need to be cleaned first, and then disinfected
using 70% Isopropyl alcohol.

The user is required to clean and disinfect the pump in the following
conditions (the earlier of the three):

® Every time there is visibly soiled.
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®  Once a week.
®  After storage at the patient’s home; even if not used.

Cleaning and disinfection instructions are identical to Cleaning and Disinfecting
Procedure on page 44.

Cleaning Electrical Connectors of Sapphire
Accessories

Cleaning the electrical connectors of all accessories is restricted to the use of
70% lsopropyl alcohol (IPA) ONLY.

1. Place the accessory on a clean and stable surface.
2. Apply IPA 70% lightly to a cloth or sponge.

3. Squeeze the cloth / sponge before cleaning, so it won't drip on the
accessory to be cleaned.

4. Swab in a rotational manner for at least 3 bi-directional rotations

(clockwise-counterclockwise).”

Figure 3.1. Cleaning Electrical Connectors

R |
®

5. Take caution and avoid dripping the reagent into the pins or pores of the
electrical connector.

6. Allow the IPA to air dry for at least 3 minutes before connecting to power.

1. Be careful not to apply excessive pressure on the connector during swab-
bing.
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Preventative Maintenance

This section describes the following preventative maintenance topics:

Routine Inspection and Maintenance Tasks .........cceeeiiiiieeriiiieiiiieeeiiieeeiins 48
Thorough Visual INSPeCtiON .....ciieeiiiii e 49
ALGIM TESEING ceuiiiiiie et e e aaaas 53
BUITE-IN TEST 1ottt ettt e ettt s e e e e e bt e s e e eaebaeeeaaes 55
Air Detection, Occlusion Sensor and Accuracy TestS .......cecevieiiieeiiiivineeineninnns 57

Routine Inspection and Maintenance Tasks

The following sections provide guidelines about inspecting and caring for the
pump before and after use.

A Take care not to drop the pump. If the pump is dropped or
appears to be damaged, cracked or dented, return it to your
local representative for inspection.

Preliminary Inspection

Before using the Sapphire pump and its accessories, check the pump for signs
of any mechanical damage.

A Do not use the pump if you identify anything which may
indicate impaired functioning of the system. In such a case,
contact the hospital biomedical engineer, or a Q Core
approved service technician.
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Post-use Procedures

The following equipment checks should be performed following each use of
the pump, and as required:

Pump Component Action

Pump Housing Check for cracks and dents.

Power Cord Verify that the power cord is undamaged.
Check the entire length of the cord, and the
plug.

Additional instructions about cleaning the delicate parts of the pump are
included below.

Thorough Visual Inspection

1. Check the pump plastic housing for cracks and broken parts. If parts are
broken or cracked, the pump must be serviced.

Figure 3.2. Visual Inspection for Cracks

Battery Cover

Door screw

Safety door
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2. Verify that the safety door is functioning properly (Figure 3.3). The door
must be free of cracks and the door latch should be intact. Check if the
door is cleaned to transparency, so you can monitor that the cassette is
properly located during set installation. If necessary, clean and dry the
safety door with a dry cloth.

Figure 3.3. Visual Inspection of Safety Door

o This figure displays the safety door design of SapphirePlus
and Multi-Therapy pumps. SapphireH100 pump has a
unique safety door design, see SapphireH100 Design on
page 171.

3. Check the cassette chamber, pumping mechanism and cassette locking
mechanism for functionality and cleanness (Figure 3.4):

a. The door latch should move to "cassette unlock position" freely and
spring back to "lock position" without any resistance, otherwise return
the pump for servicing.

b. The internal white panel should be free of foreign materials and dirt. If
necessary, use standard detergent solution to clean the connector or the
Dispatch® (Caltech) ready-to-use towels. Pay particular attention to the
area around the 4 fingers roots.
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c. The Bubble Detector (BD) must be inspected for possible cracks,
scratches or dirt. If the BD plastic shell is damaged, return the pump for
servicing. A dirty BD cover can lead to improper functioning of the BD,
creating false alarms. Verify that the BD plastic cover is clean of grease or
other foreign materials.

Figure 3.4. Visual Inspection of Cassette Chamber

Latkinz tooth i | BD (Bubble detector)

4. A properly functioning safety door must "click" itself into the open
position, and must snap itself to a secure closed position. The door has
an internal protrusion to assure correct locking of the cassette when the
door is closed. Verify that the protrusion is not broken.

Figure 3.5. Visual Inspection of Safety Door

| Protrusion

5. Check that the power-communication connector is free of foreign
materials and dirt. If necessary, clean and dry with a dry cloth.
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Figure 3.6. Visual Inspection of Power-Communication Connector

Power-Communication

connector

6. The pump has flat golden connectors (P2C) on the back of its plastic
housing. Make sure that the connectors are not loose, broken, dirty or

corroded. When cleaning the pads, take special care not to scratch its
golden surfaces.

Figure 3.7. Visual Inspection of Connectors

Golden connectors

/. The pump pressure sensor is located on the 3rd finger tip. This finger tip
should move freely and the gap between the tip and the finger should be

free of dirt, grease or foreign materials. Gently press the tip to verify that
it is moving freely.
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Figure 3.8. Visual Inspection of Pressure Sensor

o Pump must be serviced:

® In any case of cracked, broken or deformed parts of the
pump housing, the pump must be serviced. This includes
the pump housing, cassette chamber door and battery
door.

® In case of a cracked, broken or deformed BD plastic

® housing.

® Pumps suspected of being damaged must be tested for
proper performance before being returned to patient use.
This includes pumps that have been physically damaged,
or those that have fluid intrusion.

Alarm Testing

Sapphire Pumps

It is recommended to perform manual testing of the following alarms at least
once a year. Alarm testing can be conducted as part of the yearly certification.

o Before testing the alarms, make sure to disconnect the set
from the patient.
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Name of Test Procedure

Air in Line Alarm Connect a new Q Core administration set to the pump
without connecting it to the collapsible bag of water
container. Start an infusion at a rate of 100 mL/h. An Air
in Line alarm should occur.

Occlusion Alarm Start an infusion at a rate of 600 mL/h over 5 minutes.
While the pump is running, close the upstream clamp.
An Upstream Occlusion alarm should occur.
Test the Downstream Occlusion alarm by repeating the
above test, but closing the clamp or pinching the
tubing downstream while the pump is running.

If an alarm is not generated, return the pump for service.

o The operator should stand 1 meter from the pump, and
verify that the alarm can be seen and heard.

o For additional information about the Air in Line and
Occlusion alarms, refer to Chapter 6: Level 3 Alarms on
page 192.
o In software versions that support the disabling of Air
detection, please ensure that air detection is enabled (On) in

the technician options. If the air detection disabled (Off) icon
is displayed and a warning stating the air detection is
disabled (Off) appears when programming an infusion, the
Air in Line alarm will not be triggered.

Sapphire Epidural Pumps

To perform the manual testing of the Air in Line alarm and Occlusion alarm in
Sapphire Epidural pumps refer to the 'Field Air Detector Test for Sapphire,
SapphireH100 and SapphirePlus Infusion Pumps' (P/N 15025-042-0057) and
'Field Occlusion Test for Sapphire SapphireH100 and SapphirePlus Infusion
Pumps' (P/N 15020-042-0006).

The Testing Protocols can be found on the Service Portal,
https://service.qcore.com/
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Built-in Test

The pump performs automatic testing upon turning it on.

Once you start the pump by pressing on the start button, during startup the
pump is performing two test sequences:

First test sequence

® Boot version validation
®  Pump program version validation

For any failure in the built-in test, contact Q Core Medical via the Service
Portal or contact the local distributor service center.

Second sequence

e | CD Drivers version validation.
®  GUI (Graphical User Interface) version validation.

At start of this sequence failure in the LCD Drivers version validation will cause
the screen to remain inactive BLACK.

Failure in the GUI version will prompt a screen with colored lines. Test is done
automatically upon turning the pump on.

Failure resolution

For any failure in the built-in test with one of the above source of failure notes:
upgrade software version.

In case of malfunction alarm during built-in test, pump must
be serviced.
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Testing System Function

The Test system menu enables you to test basic system functionalities. Only
users with authorization levels of High or Technician have access to this menu.

> To access the Test system menu:

®  From the toolbar of the Start Up screen, select Options. Then, select
Pump configuration - Test system.

Option Descriptions/Notes

Speaker high ® On: High volume auditory signal sounds.
® Off: No auditory signal.

Speaker low ® On: Low volume auditory signal sounds.
® Off: No auditory signal.

Alarm LED ® On: The red (Alarm) LED is lit.

® Off: The red (Alarm) LED is not lit.
Charge LED ® On: The yellow (Charge) LED is lit.

® Off: The yellow (Charge) LED is not lit.
Running LED ® On: The green (Run) LED is lit.

® Off: The green (Run) LED is not lit.
Door sensor ® Closed: The safety door is closed.

® Opened: The safety door is open.

Bolus handle ¢ Released: The handle is not pressed.

® Pressed: The handle is pressed.

o To test bolus handle functionality first connect the bolus
handle to the Sapphire infusion pump. Do NOT connect
bolus handle to mini cradle splitter.

o Sapphire Plus devices do not have the option for Patient
Bolus, therefore, if a bolus handle is not available for this
test, mark Pass and proceed.
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Air Detection, Occlusion Sensor and Accuracy Tests

There are two methods for checking the pump's air detection, occlusion
sensor and accuracy:

FasTest PM Test Method .......ceuuurimimimiiiiiiieie et 100
Annual Certification Test (ACT) Method .......c.ccoueviiiiiiiiiiiieeiice e, 127
o We recommend using the FasTest PM Test Method.

The FasTest PM method allows you to perform the tests described in the table
below.

Name of Test Procedure

Air Detector & Accuracy This test involves introducing a pre-specified
amount of air into the administration set.
The application checks if the pump detected air in
the system, and whether the measured infused
volume is correct (checks it versus the expected
volume).

Occlusion Sensor This test involves delivering a known volume of
fluid; then, creating pressure in the system - caused
by introducing a specific amount of air into the
administration set against a closed clamp.

All of the functional tests included in the FasTest PM process and their specific
procedures are detailed in FasTest PM Test Method on page 100.

Battery Care Information

The Sapphire pump can operate on battery power, enabling operation of the
pump during an electrical power failure, during patient transport or during
ambulatory care.

57 Sapphire Infusion Pump Service Manual



When working on battery power (disconnected from main power supply) the
battery charge level icon, at the upper right corner of the indicators bar,
indicates remaining battery capacity. Check the status of the battery charge
level icon regularly.

Number of Bars in Icon Approximate Remaining Battery Capacity

5 100%
75%
50%
25%

Low

- N W b

o You can also check the status of the battery using the
Options menu. For details, refer to the Sapphire User
Manual, Viewing System Parameters.

Battery operation time is dependent upon the condition of the battery, which
varies according to temperature conditions, battery age, frequency of
charging, and conditions of storage and use.

An alarm is triggered when there are 30 minutes left until battery depletion.
This time may depend on the delivery rate, the frequency of pressing keys,
and whether the backlight is on. When the Battery Depletion alarm sounds, or
following long periods of storage, connect the pump to the power supply.
Notification messages begin appearing on the Main Display of the pump 2
weeks before battery life expiration. When the battery life expires, the pump
allows you to finish the current infusion and then turns off. Make sure to
charge the batteries at least once a year, and replace the batteries every 2
years or every 500 charging cycles.
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Battery Classification

The UL 1642 Standard for Lithium batteries classifies the Lithium-lon battery
used in the Sapphire pump as follows:

e Secondary battery (rechargeable)

®  Technician replaceable

Battery Safety Information

When working with the battery, adhere to the safety precautions and
recommendations listed below.

: Battery Safety Guidelines
®  Ensure that only a rechargeable Lithium lon (Li-lon) battery (supplied by Q
Core Medical Ltd.) is used.

® In case of rust, bad odor, overheating, and/or other irregularities when
using the battery pack for the first time, return it to your local
representative.

® Avoid any contact with any liquid.

® Do not open the battery casing.

®  Store batteries in a closed carton.

®  Short term storage temperature should be below 35°C (95°F).

Long Term Battery Storage

When you store batteries for extended periods of time, ensure the following

conditions:

*  Well-ventilated facility, free of a corrosive gas atmosphere

®  Low humidity environment of less than 85% RH.

® Storage temperature should be between -20° C (-4° F) to +35° C (+95°F).
The recommended temperature is 23° £3° C (73° £5° F).

Storage at low temperatures may affect initial battery
performance. Storage at high temperatures may degrade
battery performance.
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Charging the Battery

The Sapphire pump should be used with a Q Core battery
only.

Before initial use of the Sapphire pump, the battery must be charged for at
least 6 hours. The battery must also be charged if it has been disconnected
from the pump unit for more than 6 months. While the pump is in storage,
recharge the battery at least every 12 months.

The pump can operate while it is being charged.

When using the pump while connected to the charger,

A ensure that the pump is attached securely to the charger, the
mini cradle is attached securely to an IV pole, and the power
cord is secure, to prevent entanglements that might cause
strangulation.
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To preserve battery life, connect the pump to the main power supply using
the charger whenever possible.

A Before charging the battery, ensure that the device is
completely dry. Failure to do so may compromise patient
safety.
o While connected to a power supply and charging, the

Charge (yellow) LED blinks.

If the pump is turned off, the following information is
displayed:

® Status (Charging or Battery fully charged)
® For Rev 14.5 SW only:

® Pump serial number

® Software version

® Drug library number

® Days to pump checkup

The Charge (yellow) LED stops blinking when the battery is
fully charged.

> To charge the battery:

1. Plug the Q Core supplied power supply cord into the main power supply.
2. Plug the power cord into the pump power socket or into the splitter
connector, with the white arrows or red dot facing up.
3.

On the front of the pump, verify that the Charge LED status indicator is
ON (blinking yellow light).

4. The battery is fully charged when the charge LED is steady On.
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Battery Maintenance

To promote maximum battery life, the following procedures should be
performed at regular intervals.

Frequency Action

Following each use of the pump  Check the status of battery charge, and
recharge as necessary.

Every 2 years, or every 500 Replace the battery
charging cycles

Splitter Assembly Instructions

Required parts and tools:

e Splitter kit (includes 2 screws)
®  Minicradle

e  Screwdriver

Assembly process:

Insert the splitter to the mini cradle as described in Figure 3.9, and tighten
using the 2 included screws.

Figure 3.9. Splitter Assembly
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Sapphire Multi-Pump Mounting System

Read the directions before assembling or using the Sapphire Multi-Pump

Mounting System.

Mounting System safety guidelines:

Before and during the use of the Mounting System, always adhere to the
following safety precautions and guidelines:

A Warnings:

63

Verify the mini cradles are securely attached to the Mounting System and
that the Mounting System is securely attached to the IV pole before
attaching the pumps.

Do not transport the Mounting System while mounted on an IV pole.
Detach and carry using the handle.

Verify the IV pole is not moving, tilting or wavering when mounted with a
Mounting System.

Before using the Mounting System, make sure the Mounting System
power supply and all cords are completely dry.

Always connect the AC input cord to the Mounting System power supply,
before connecting it to a power outlet.

Make sure that the AC input cord is fully inserted into the Mounting
System power supply socket and into the power outlet.

Always disconnect the AC input cord from the power outlet before
disconnecting it from the Mounting System power supply.

Cautions:

Use only Q Core approved AC input cord and power supply with the
Mounting System.

To avoid risk of electric shock, the mounting system power supply must
be connected to a power outlet with protective earth.
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® To avoid entanglement of lines and cords, do not mount more than 4
Mounting Systems on a single IV pole.

o It is recommended to use additional IV bag hooks (not
supplied by Q Core) when mounting more than two
Mounting System on a single IV pole.

Overview

The Mounting System is designed to facilitate the use of multiple pumps
while saving valuable bed-side space and providing power consolidation. The
Mounting System is designed to accommodate three mini cradles, and charge
three pumps via a single power outlet, all attached to an IV pole via a single
clamp. The Mounting System can also accommodate the use of a single PCA
Lockbox 250 when mounted on the right-hand mini cradle among the three.

The Mounting System is compatible with the following infusion pumps:
Sapphire Multi Therapy Infusion Pump, Sapphire PCA Infusion Pump,
Sapphire TPN Infusion Pump, Sapphire Epidural Infusion Pump,
SapphireH100 Infusion Pump, SapphirePlus Infusion Pump, and IVVET
Infusion Pump.

o It is recommended to use mini cradles with a splitter in order
to facilitate attachment and detachment of pumps.

Unpacking the Mounting System

When unpacking the Mounting System, inspect each item to confirm that it is
undamaged. The following items should be included:

® Sapphire Multi-Pump Mounting System, P/N: 15171-120-0001-MEC

®  Power supply with three DC output connectors

® AC input cord, compatible with the regional power outlet type

® Clamp knob key
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Figure 3.10. Mounting system

A. Mounting System power supply F. Clamp

B. Latch G. Cord hook

C. Carry handle H. AC input cord

D. Clamp knob I. DC output connector
E. Clips J. Power supply LED

Mounting System setup instructions

o It is recommended to first attach the Mounting System
to the IV pole before attaching the mini cradles to the
Mounting System

Attaching the Mounting System to an IV pole

1. Loosen the clamp knob (Figure 3.10 D) by rotating it counter-clockwise.

2. Firmly hold the Mounting System and place the clamp (Figure 3.10 F) on
an IV pole with the carry handle (Figure 3.10 C) facing upwards.

3. Tighten the clamp knob by rotating it clockwise (Figure 3.11).
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Figure 3.11.  Clamp knob

a

o To prevent detaching from the IV pole, the Mounting System
can be locked to the pole by removing the knob cap or knob
key from the clamp knob.

Attaching a mini cradle to the Mounting System

1. Pull the pump holder (Figure 3.12 B) away from the base (Figure 3.12 E) and
rotate it to a position where the mini cradle knob (Figure 3.12 F) points
downward and the top hook (Figure 3.12 A) points upward.

Figure 3.12.  Attaching the mini cradle

A. Top hook E. Mini cradle base
B. Pump holder F. Mini cradle knob
C. Bottoms hooks G. Splitter socket
D. Mini cradle vise H. Proper position
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o Place the mini cradles according to the markings on the
Mounting System, between the designated lines (Figure
3.14).

Loosen the mini cradle knob (Figure 3.12 F) to maximum extent by rotating
it.
Tilt the mini cradle and place the open vise (Figure 3.12 D) on the top of

the Mounting System (Figure 3.13 A). Align the cradle and tighten the
knob by rotating it (Figure 3.13 B).

Figure 3.13.  Tilting the mini cradle

Plug a DC output connector (Figure 3.10 |) to the mini cradle splitter (Figure
3.12 G).

Fasten the DC output cables to the clips located on the bottom of the
Mounting System (Figure 3.10 E).

Plug the AC input cord (Figure 3.10 H) to the power outlet. Verify that the
Mounting System power supply LED (Figure 3.11 J) is ON.
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Figure 3.14.  Fully assembled Mounting System

@ Fully assembled Mounting System

Attaching a pump to a mini cradle

1. Firstinsert the pump into the bottom hooks of the mini cradle (Figure 3.12
C), and then click the pump into the top hook (Figure 3.12 A).

2. Verify that the charging connector is plugged into the splitter socket
(Figure 3.12 G) or the pump socket.

Detaching a pump from a mini cradle

1. Before detaching the pump unplug the DC output cord from the pump
socket (if connected).

2. Hold the pump and press the top hook (Figure 3.12 A) backwards.

When transporting the Mounting System, detach it from the IV pole

1. Unplug the AC input cord from the power outlet.

2. Firmly hold the Mounting System and rotate the clamp knob
counter-clockwise, until the Mounting System is loose.

3. To carry the Mounting System always use the dedicated carry handle.
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Cleaning and disinfecting the Mounting System

o To clean the Mounting System thoroughly, remove the
Mounting System power supply and all the mini
cradles

Cleaning of the Mounting System involves wiping it with Dispatch® (Caltech)
ready-to-use towels or with the following cleaning and disinfection agents:

°  Virex® Il 256
e Klor DeTM (Chlorine tablets)
e 70% Isopropyl alcohol

Mounting System power supply servicing

Remove the Mounting System power supply for maintenance or cleaning, by
performing the following steps:

Disassemble the Mounting System power supply from the Mounting System:
1. Disconnect the AC input cord from the power outlet.
2. Unplug the DC output connectors from the mini cradles.

3. Push the latch and slide the Mounting System power supply out of its
housing (Figure 3.15 A).

4. Take the AC input cord out of the cord hook (Figure 3.15 B).

Reassemble the Mounting System power supply to the Mounting System:
1. Place the AC input cord in the cord hook

2. Slide the Mounting System power supply back to its housing till the latch
snaps into place (Figure 3.15 C).

3. Refer to the Mounting System setup instructions to reassemble the
Mounting System and prepare it for use.
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Figure 3.15.  Reassemble the Mounting System power supply
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Troubleshooting

Problem Problem Cause

Pump is not charging ~ Mounting System
while attached tothe  power supply is
mini cradle on the defective
Mounting System

AC input cord

plugged improperly
or defective

DC output connector

plugged improperly
or defective

Splitter socket is
defective

Integrated Power Supply (IPS)

Solution

Replace the Mounting System
power supply with another Q Core
approved Mounting System power
supply.

Verify that the AC input cord is
properly connected and that the
Mounting System power supply
LED is ON. Otherwise, replace it
with another Q Core approved AC
input cord.

Verify that the DC output
connector is properly plugged to
the splitter socket. Otherwise,
replace the Mounting System
power supply with another Q Core
approved Mounting System power
supply.

Replace the splitter or the mini
cradle or plug the DC output
connector directly into the pump
socket.

The Integrated Power Supply (IPS) is a power supply that is assembled into
the Mini Cradle to supply power to the pump. Specifications of the power

supply include:
® Input voltage: 100-240 VAC
®  Output voltage: 10 VDC
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> To connect the AC Power Cord to the IPS:
1. Connect the Q Core AC Power Cord to the IPS.
2. Connect the Cord Retainer to the IPS, using a Philips head screwdriver.

The cord retainer is an integral part of the IPS, and must be
connected prior to initial use.

> To charge the battery:
1. Plug the Q Core AC Power Cord into the main power supply source.

2. On the back of the IPS B, verify that the Power LED status indicator is On
(blue light).

3. Mount the pump into the mini cradle.

On the front of the pump, verify that the Charge LED status indicator is
On (blinking yellow light).

> To disconnect the AC Power Cord from the IPS:
1. Unplug the Q Core AC Power Cord from the main power supply source.

2. Disconnect the Cord Retainer from the IPS, using a Philips head
screwdriver.

3. Remove the Q Core AC Power Cord from the IPS.

Maintenance and Storage 72



Sapphire Multi-Pump Mounting System
Compatible with IPS B

Safety Guidelines

Before and during the use of the Mounting System Compatible with IPS B, always
adhere to the following safety precautions and guidelines:

A

®  \Verify the mini cradles with IPS are securely attached to the Mounting System
Compatible with IPS B and that the Mounting System Compatible with IPS B is
securely attached to the IV pole before attaching the pumps.

® Do not transport the Mounting System Compatible with IPS B while mounted on
an IV pole. Detach and carry using the handle.

Verify the IV pole is not moving, tilting or wavering when mounted with a
Mounting System Compatible with IPS B.

®  Before using the Mounting System Compatible with IPS B, make sure all the
Mounting System Compeatible with IPS B cords are completely dry.

®  To avoid risk of electric shock the Trident AC power cord must be connected to a
power outlet with protective earth.

®  Use only Q Core approved Trident AC power cord with the Mounting System
Compeatible with IPS B.

® To avoid entanglement of lines and cords, do not mount more than 4 Mounting
Systems on a single IV pole.

0 It is recommended to use additional IV bag hooks (not supplied by
Q Core) when mounting more than two Mounting System
Compatible with IPS B on a single IV pole.
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Product overview

The Mounting System Compatible with IPS B is designed to facilitate the use of
multiple pumps while saving valuable bed-side space and providing power
consolidation. The Mounting System Compatible with IPS B is designed to
accommodate exactly three mini cradles that include IPS, and charge three pumps via
a single AC power cord, all attached to an IV pole via a single clamp. The Mounting
System Compatible with IPS B can also accommodate the use of a single PCA Lockbox
250 when mounted on the right-hand mini cradle among the three.

The Mounting System Compatible with IPS B is compatible with the following infusion
pumps: Sapphire Multi Therapy Infusion Pump, Sapphire PCA Infusion Pump, Sapphire
TPN Infusion Pump, Sapphire Epidural Infusion Pump, SapphireH100 Infusion Pump,
SapphirePlus Infusion Pump, and IVVET Infusion Pump.

Unpacking the Mounting System Compatible with IPS B

When unpacking the Mounting System Compatible with IPS B, inspect each item to
confirm that it is undamaged. The following items should be included:

®  Sapphire Multi-Pump Mounting System Compatible with IPS B
®  Trident AC Power cord

¢  Clamp knob key

Figure 3.16. Mounting System Compatible with IPS B

ltem Description

A Carry Handle
B Clamp knob
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ltem Description

C Clamp
D Cord Hook
Figure 3.17. Mounting System Compatible with IPS B Trident Power Cord

—®
(©

Ohs ©

[tem Description

A Power cord connector
B Power cord plug

C Short cord

D Long cords

Mounting Instructions

It is recommended to first attach the Mounting System Compatible with IPS B to the IV
pole before attaching the mini cradles with IPS to the Mounting System Compatible
with IPS B.

Attaching to an IV Pole

1. Loosen the clamp knob (Figure 3.16, Item #B) by rotating it counter-clockwise.

2. Firmly hold the Mounting System Compatible with IPS B and place the clamp
(Figure 3.16, Item #C) on an IV pole with the carry handle (Figure 3.16, Item #A)
facing upwards.

3. Tighten the clamp knob by rotating it clockwise (Figure 3.18).
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Figure 3.18. Attachment to an IV Pole

o To prevent detaching from the IV pole, the Mounting System
Compatible with IPS B can be locked to the pole by removing the
knob cap or knob key from the clamp knob.
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Attaching a Mini Cradle with IPS to the Mounting System Compatible with
IPS B

1. Pull the pump holder (Figure 3.19, Item #B) away from the base (Figure 3.19,
[tem #E) and rotate it to a position where the mini cradle knob (Figure 3.19,
ltem #F) points downward and the top hook (Figure 3.19, ltem #A) points upward.

Figure 3.19. Mini Cradle with IPS Parts

ltem Description

A Top hook

Pump holder
Bottoms hooks
Mini cradle vise
Mini cradle base
Mini cradle knob
IPS

A MmO W

o Place the mini cradles with IPS according to the markings on the
Mounting System Compatible with IPS B, between the designated
lines (Figure 8).
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2. Loosen the mini cradle knob (Figure 3.19, ltem #F) to maximum extent by rotating
it.
3. Tilt the mini cradle and place the open vise (Figure 3.19, Item #D) on the top of the

Mounting System Compatible with IPS B (Figure 3.20, Item #A). Align the cradle
and tighten the knob by rotating it (Figure 3.20, ltem #B).

Figure 3.20. Mounted Cradle

4. Plug each of the Trident AC Power cord connectors (Figure 3.17, [tem #A) to the
IPS sockets (Figure 3.21) of the mini cradles (the Trident AC power short cord
should be connected to the middle Mini Cradle).

Figure 3.21. Connected by Trident AC

IPS socket Short cord

5. Connect the cord retainers to each IPS using a Philips head screwdriver (Figure
3.22).

The cord retainer is an integral part of the IPS and must be connected prior to
initial use.
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6. Place the Trident AC Power Cord in the Mounting System Compatible with IPS B
cord hook (Figure 3.16, Item #D).

/. Plug the Trident AC Power cord (Figure 3.17, ltem #B) to the power outlet. Verify
that the LEDs on the back of the IPSs are on.

Figure 3.22. Using the Cord Retainer

RN

Figure 3.23. Fully Assembled Mounting System with IPS B
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Attaching a pump to a mini cradle with IPS

First insert the pump into the bottom hooks of the mini cradle (Figure 3.19, Item #C),
and then click the pump into the top hook (Figure 3.19, Item #A).

Detaching a pump from a mini cradle with IPS

Hold the pump and press the top hook (Figure 3.19, Item #A) backwards.

Detaching a pump from an IV Pole

When transporting the Mounting System Compatible with IPS B, detach it from the IV
pole:

1. Unplug the AC power cord from the power outlet.

2. Firmly hold the Mounting System Compatible with IPS B and rotate the clamp
knob counter-clockwise, until the Mounting System Compatible with IPS B is
loose.

3. To carry the Mounting System Compatible with IPS B always use the dedicated

carry handle.

0 To clean the Mounting System Compatible with IPS B
thoroughly, remove all the mini cradles. Refer to Cleaning and
Disinfecting Procedure on page 44 for more information about
the cleaning process and approved cleaning materials.

0 Always contact a certified technician in cases of Mounting

System Compatible with IPS B electrical and mechanical
malfunctions.

Transport and Storage

The pump should always be transported in a protective case internally
padded with cushioning material. It is best to use the original packaging.
During handling and transport, protect the pump and the case from water,
excessive humidity, and heat sources.
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To safeguard the pump against prolonged exposure to dust and moisture, the
pump must be stored in a clean and dry environment. It is recommended that
the pump remain plugged in during storage, in order to maintain the battery
at full charge. If the pump is disconnected from the power supply, or is in
storage without being connected to power for several months, check the
battery level, and recharge the battery before using the pump (see Charging
the Battery on page 60).

For any storage period, make sure that the Q Core administration cassette is
disconnected from the pump, and that the safety door over the pump
mechanism is closed. Specific recommendations for long term storage
conditions are listed in the following table.

Condition Parameters

Temperature -40° C (-40° F) to +70° C (+158°F)
Relative humidity 15% RH to 95% RH
Atmospheric pressure 70 kPa to 106 kPa (500 hPa to 1060 hPa)

Q Core Service for Sapphire Pumps

If poumps require service please contact Q Core Medlical Ltd., or a local
distributor. For more information refer to page 268.

Pumps will be serviced as follows:

® Directly by trained technical personnel for First Level Support for tasks
they have been trained for.

® Inlocal service centers authorized by Q Core Medical Ltd.

®  Ship pumps to a Q Core Medical Ltd. International Service Center for
servicing according to the instructions below.
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Q Core Product Return Policy

Devices may be shipped to Q Core Medical or to a local distributor for
service. For more information refer to page 268. Please adhere to the
following guidelines in order to ensure effective and quality processing of
your claim(s) and refer to COMP-5000-0000034, Returned Materials Policy on
Q Core MedicalService Portal (https://service.qcore.com/). For more
information regarding the Service Portal, refer to Service Portal Work
Instructions, 16019-049-0001-SRV.

Devices will not be accepted as returned without a Return Material
Authorization (RMA) number. Returns received without authorization will not
be processed.

1.

Request a RMA through one of the following methods:

® Contact your Q Core account manager directly

* Send a RMA request form to service@qcore.com or to a local
distributor. For more information refer to page 268.

Provide a detailed description of problem encountered with the device.

The request will be reviewed within 24 hours; do not send your item until
you have received an RMA Number.

A notification email will be sent to you when your RMA Request will be
approved. Print the RMA form and Packing Slip and attach them to the
returned device. The forms can be obtained from Q Core FTP site

(https://qcore.smartfile.com).
Clean and disinfect the pump in accordance with Q Core's pump

cleaning and disinfection guidelines prior packaging it for shipment, refer
to Cleaning and Disinfecting the Pump on page 43.
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Chapter 4: Performing Pump

Certification Test

There are two options for performing the Certification Test:

FasTest PM Test Method .......ccoouvuiiiiiiiiiiiiieieeiiiiiiee et 100

Annual Certification Test (ACT) Method .........cccoovveeiiiiiiiiiiii e 127

o We recommend using the FasTest PM Test Method.
Introduction

Pump Certification Test Overview

The certification process contains a sequence of maintenance checks that
need to be performed annually on the Sapphire infusion pump. The
certification procedures are briefly described in the following table.

Maintenance Check Description

Visual inspection (including Checking for pump integrity: cracks, loose parts,

mechanical and electrical connectors, touch screen and other tests, as

inspections) defined in Chapter 3: Maintenance and Storage on
page 42.

Safety features testing Checking speaker, LEDs, door sensor and bolus
handle

Calibration verification Performing tests that determine whether

calibration is necessary.
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The current chapter explains the annual certification process, with special
emphasis on the calibration verification tests. The certification process is
supported by Q Core's FasTest PM or Annual Certification Kit and Software.
The kit includes tools for performing the tests, as well as a PC program that
provides trained technicians with step-by-step instructions for how to perform
the tests.

Certification Due Date Counting

When a certification process is completed, the next certification date is
automatically set on the pump to 380 days from the date shown on the PC
that is used to perform the test (Tolerance +7 days).

Sapphire Multi-Therapy, Sapphire Epidural, SapphireH100 & SapphirePlus

The start date in cases where Certification has not yet been performed - for
example, Unused Infusion Pump — will be the shorter period of the following
options:

® 10 working hours.

® 2 years from shipment or manufacturing date
(for SapphireH100 — 180 days).

SapphirePlus Software 14.50.0

®  The next certification date on SapphirePlus SW rev 14.50.0 is referred to
as Next Checkup. The Next Checkup date is displayed on the pump:

Options - View - View system - Next checkup.
®  After burning software 14.50.0, the next checkup date will be extended
by two years from the last certification.

® If the FasTest PM/ACT was performed and passed on a SapphirePlus
pump with software 14.50.0, the next checkup date will be two years from
the date the FasTest PM/ACT was performed.

o The certificate provided at the end of the certification will
display the date of the next checkup as one year from the
day the certification was performed.
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Testing Rationale of the Certification Process

The certification process involves a visual and safety inspection, and a series
of tests on the pump - to determine whether or not the pump requires
calibration. The tests need to be performed once a year by a trained
technician.

The Sapphire pump saves the date of the last certification process, and
automatically displays the following messages on the pump’s Main Display,
indicating that the next required testing date is approaching:

e  Annual certification due in 2 weeks. Please contact trained technician.
®  Annual certification due in 2 days. Please contact trained technician.
®  Annual certification date is overdue. Please contact trained technician.

o In Sapphire Multi-therapy and Sapphire Epidural Rev 15

these messages are not displayed.

Shared Certification Notes

The instructions in this section are shared to both the FasTest PM and the ACT
certification methods.

System Requirements

Before installing the software, verify that the following requirements are met:
® Operating System: Windows 7, Windows 10 (for ACT only: Windows 8)
.NET Framework 4.0

® FasTest PM/ACT setup file: an ".msi" or ".exe" file

e Screen Resolution: 1024:768 (minimum), 96 DPI

® Memory: 4GB

® Internet Access
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Acquiring the Software

The Certification PC tool software can be obtained from Q Core FTP site

(https://qcore.smartfile.com).For information regarding the FTP site, refer to
FTP site on page 32.

Please note that only trained technicians registered with the company will be
cleared to receive the software.

Logging In

The user is requested to insert the username and password provided by

Q Core Medical. Contact Q Core at service@qcore.com for a new password,
or if username or password have been forgotten.

Figure 4.1. Login Screen

S X
Login using the username and password you were
provided with by Q Core Medical.

Authorized technician username:

Password:

o FasTest PM is available for rev15 users and licensed Service
Centers.

Station Setup

This section describes how to connect the pumps to the PC via COM ports.
Each pump adequately connected, will immediately be presented as a station
on the left pane of the screen. There might be a lag between the pump and
computer screen, please wait for the PC and pump to synchronize and follow
the instructions on the screen.
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You can connect a single pump via serial port (see To connect via a Serial
Port: on page 88); for configuring additional COM ports to your PC, use the
USB to 4-port serial RS232 adapter, see the following explanation on page 88.

o It is recommended to configure all COM ports to the PC
application before starting a test. Configuring an additional
COM port while a test is running is not possible.

> To connect via a Serial Port:
1. Open the Annual Certification program; log into the program.
2. Choose the Setup link at the upper right corner. The following window

appears:
Figure 4.2. Stations Dialog Box
For each of the Stations select an available COM port.
Station 1: |COM 1 Y
Station 2: | Not Set Y
Station 3: |Not Set S
Station 4: | Not Set v
Station 5: |not Set )
Station 6: |Not Set Y
Station 7: |not Set M
Station 8: |not Set M

More COM ports can be added using the USB to 4-port
serial R$232 adapter.

3. Choose a free COM for each station needed.

4. Confirm selection by clicking the OK button. Your selection will be saved
for the next use of the software.

> To use the Q Core USB to 4-port serial RS232 adapter (for
enabling additional COM ports):

The USB to 4-port serial RS232 adapter provides 4 external COM ports to
your computer (P/N 15077-000-0001). Follow the DFU instructions for installation.
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The Testing Screen

This section provides an overview of the structure and features of the annual
Certification Software screen.

Figure 4.3. Testing Screen
Q Core Medical FasTest PM - [SN 300135347] e

@
SAPPHIRE FasTest PM
> Station 1
NEE®E Occlusion Sensor (SN 300135347):
> Station 2 Test

NEEGE

1P | Help Avout | ‘Setup | Close\il
£ (Logout) "

7. I“"Wﬁ“"

v Station 3

Clamp the administration set.
1! Getting Started 1

2 Prime

3 Air Detector & Accuracy
5 Resuits

Press “Start”
[to start the test]

The main portion of each page of the application consists of a "main screen”
which provides step-by-step instructions for performing the current stage of
testing. The header of each page provides the number of the currently
selected Station, the name of the test and the specific test-step being
conducted (for example, Occlusion Sensor (Station 3): Clamp the
administration set; then, press Start to start the test).

The Station pane, at the left side of each page, provides information about
the testing status of each Station. For details, refer to Working with the Station
Pane on page 90.
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The following links are available at the upper right corner of each page:

Name of Link Function/Notes

Refresh active pump Refreshes the display of the pump that is
connected to the active station (see Working
with the Station Pane on page 90).

Help Provides more detailed information/
instructions about certification testing.

About Provides information about the software
version and corresponding pump versions.

Setup Configures stations to available COM ports.
(See Working with the Station Pane on page 90.)

Close Provides option to close the current/all tests,
and to exit the program.

Login/Logout Enters/exits the application.

Additionally, name of the user that logged in is also displayed before the
Logout link.

E Working with the Station Pane

After the pumps are connected to the computer and turned on (Launching the
Annual Certification Process on page 135), the Station Pane becomes active.
Each Station corresponds to a pump that is connected to the computer.
Stations that have no pump connected to them (such as Station 3 in Figure 4.4)

are disabled.
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The Station pane provides a snapshot of the status of each pump throughout
the testing process. Each Station has five numbered circles, corresponding to
the stages of testing. The circle that is highlighted represents the stage that
the pump is currently in. To help differentiate between the pumps, the
numbers of each Station are coded in a different color. To help associate
between the pump tested and its depiction on the screen, the pump's display
is marked with a rectangle colored with the color code on the computer
screen.

o In Rev. 15, when the pump is connect to the PC the
following icon will be displayed at the top right corner of the

pump's screen: E

Figure 4.4. Station Pane

Q Core Medical FasTest PM - [SN 300199114]

Q
SAPPHIRE

v Station 1
1 Getting Started

3 Air Detector & Accuracy
4" Occlusion Sensor

5 Results

> Station 2 connected
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> To perform the Preliminary Inspections:

1. Perform Thorough Visual Inspection, as described in Thorough Visual
Inspection on page 49. Check Pass or Fail in the box next to Visual
inspections according to findings.

2. Perform Functional Tests, as described in Testing System Function on
page 56. Check Pass or Fail on applicable boxes next to Functional
Inspections according to findings.

3. When using an SC bolus handle (bolus handle with a grey button), test
the bolus handle prior to connecting the pump to the computer.
o The Preliminary Inspections verify that the pump isin a

proper condition before starting the certification.
A pump that failed one of the inspection tests is considered
as Failed and must be serviced. A Failed pump cannot
proceed to the Certification process.
A pump that passed all of the inspection tests is marked as
Pass, and can continue to the Certification process.
Figure 4.5. Getting Started Screen
@Q Core Medica FasTest PMIZISN 300135347)
swrie FasTest PM ”
oecae Getting Started (SN 300135347);
> Station 2 Preliminary Inspections
te e Before conducting the calibration verification tests, perform the following preliminary Inspections.
v Station 3 If one of the below Is marked fall please return for service.
2 Prime Pass Fail
31 Air Detector & Accuracy 1 Visual inspection v

4 Occlusion Sensor
£ Results
2 Functional inspection
> Station 4
deeeee Speaker
Alarm LED
Charge LED

Run LED

Door sensor

L N NSNS

Bolus Handle
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Shared Troubleshooting

Communication

The following issues can arise due to communication problems in either the
FasTest PM or the ACT certification methods:

Problem Management

The following message appears Contact your IT department — re-install the
after trying to install the software as an Administrator.

certification Software: Service

'Q Core Logger Server'

(QCorelLoggerSrv) failed to

start. Verify that you have

sufficient privileges to start

system services.

The cable is connected and There may be a delay, please wait until the pump
COM port is selected but the appears.
pump does not appear.

Username and password were  Check that:

entered, yet the application ® The PC is connected to the internet.
couldn't connect to the Q Core
server.

An error message appears:
"Failed to connect to the

® The firewall allows communication to outer
servers. Consult your IT department regarding
security instructions in your facility before
changing the firewall settings.

server". )
® |f the error message keeps appearing, contact
service@qcore.com or a local distributor. Refer
to page 268.
The following error message ® Verify the communication cable is properly

appears: "Connection with the attached to the pump and the PC.
pump has lost (no samples in 4

; ® Restart the certification process.
seconds)".

® |f problem persists, replace communication
cable.
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Login and Kit Entry

The following issues can arise due to login and kit entry problems:

Problem Management

Username was entered, and the  ® Make sure to enter the correct username you
following error message were given.
appears: "Username should

’ .=, ®Toretrieve the username or to acquire a new
contain only letters and digits".

one, contact service@qcore.com or a local
distributor. Refer to page 268.

Password was entered, and the ~ ® Make sure to enter the correct password you
following error message were given.
appears: "Password should

A . ® Toretrieve the password or to acquire a new
contain only letters and digits".

one, contact service@qcore.com or a local
distributor. Refer to page 268.

Username and password were e Make sure to enter the correct username and
entered, and the following error password you were given_

message appears: "Unknown ® To retrieve the username and password or to

User". .
acquire new ones, contact
service@qcore.com or a local distributor. Refer
to page 268.

A kit number that was not Check that:

approved by Q Core Serverwas e The correct kit Serial number was entered.
entered, the following error

message appears: "Invalid Kit
Number".

® The serial number matches the barcode number
that is located on the kit DFU.
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General

The following are general issues that can arise during certification testing:

Problem Management

Station appears inactive Verify there are no other active PC programs that
although being properly use the same configured COM port.

configured.

The user double-clicked a Check that:

station with an attached pump e The pump is connected to the matching COM
that is not live; the following port.

error message appears:
"There is no pump attached to
this station. Action Canceled".

® The pump is turned on or attached to a power
supply.

The user double clicked a Log into the software.
station, but no user is logged

in, the following error message

appears: "No User Logged In.

Login first, and then start the

certification process".

An alarm was triggered in the ® Refer to Alarms and Troubleshooting on page 189

pump that is not related for and attend the alarm as instructed.
the specific stage, the

following error message
appears:

"Critical Alarm Occurred.
Check pump. Certification is
aborted".

® Restart the certification process.
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Problem

Some of the graphic
information was not
transferred and is missing from
the pump screen (title, text,
buttons).

The next certification due
date, as it appears in the
certification provided at the
end of the certification
process, is different than the
next certification due date in
the View system menu on
the pump.

Performing Pump Certification Test

Management

® |f text or title is missing, or a button is missing,
or an image is missing, from the PC, select the
active pump; then, press the Refresh Active
Pump link at the top-right. The display on the
selected pump will be refreshed.

® |f a button is missing, try to press its location. If
only the image is missing, the function will
work. If pressing on the button location doesn't
work, close the current test and restart the
process.

® The next certification due date as it appears in
the certification is the correct one.

® The next certification due date in the View
system menu will be updated with the correct
date as it appears in the certification, after the
pump has been operating for one second.

® There may be a difference of one day between
the dates that appear as the next certification
due date in the Certification, and in the
View system menu.
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The certification process will prompt a message in the following cases:

Case

Unauthorized pump
software version.

Obsolete certification
software version.

97

Message Displayed

The software version
installed on this pump is
obsolete!

Please update the software
to an authorized version
before proceeding with the
process.

Authorized software
versions are available for
download from Q Core FTP
site at https://
qgcore.smartfile.com/.

A valid username and
password is required to
access the website.

The certification software
version you are using is out
of date.

A new version of the
certification software is
available for download from
Q Core FTP site at https://
qgcore.smartfile.com/.

A valid username and
password is required to
access the website.

Solution

Update the pump software
to an approved version
before proceeding.
Approved pump software
versions are available for
download on the Q Core
Medical FTP site at https://
qcore.smartfile.com/.

Valid username and
password are required in
order to access the website.

Install the most updated
certification software.
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Case Message Displayed

Incompatible display ~ FasTest PM and Annual

settings — Windows 7 certifications are designed

and Windows 8. to work with a screen
resolution of 96 DPI (Dots
Per Inch) only. Please
change your display
settings and reopen the
application.

Performing Pump Certification Test

Solution

1. Right-click on an empty
area on your desktop and
select Display.

2. Change the size of text to

100% and exit settings.
Note: if "Change the size
of text" option is grayed
out, log out of Windows;
then, log in again.

3. Reopen Q Core PC tool,
and verify that the PC tool
works.
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Case Message Displayed

Incompatible display ~ FasTest PM and Annual

settings — Certification are designed

Windows 10 to work with a screen
resolution of 96 DPI (Dots
Per Inch) only. Please
change your display
settings and reopen the
application.

Solution

Change DPI Scaling for
the entire PC

1. Open Settings, and
click System Start -
Settings - View

Or

Right-click on an empty
area on your desktop and
select Display Settings.
2. In the System Settings
screen, click the Display
option.

3. Change the size of text to
100% and exit the settings.
Note: If Change the size
of text option is grayed
out, log out of Windows;
then, log in again.

4. Reopen Q Core PC tool
and verify that PC tool
works.

Change DPI Scaling for
Q CORE Apps Only

1. Right-click FasTest PM/
Annual Certification
Test - Price Properties.
2. In the Computably tab;
then, click Settings -
Change high DPI settings =
Select check box, setting to
fix scaling problems for
these programs instead of
the one in settings.
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FasTest PM Test Method

The following sections detail the FasTest PM certification process for the
Sapphire pump:

FasTest PM Certification OVEIVIEW ........ceveeiiviiiineeiiiiiiineeeeeiiiiee e eeeeiiineeeens 100
SYStEM REQUIFEMENTS ouiieiiiiieiie et e e et e e e e e e ae et eaneanas 86
FasTest PM Calibration Verification Process ..........cceeveviieereiionereieeeriieeeennn. 101
FasTest PM Certification Kit .......coeviiiiiiiieriiiiiiiiene e 102
FasTest PM Certification SOftWare .......cccccevivivieriiiiiiiiiiee e 104
FasTest PM Certification TESt .....cvveeieiieiiiiie et e e e e 105
FasTest PM — Following the Certification ..........cccccvieiiiiiieiiiiineiiiiiece e, 122

FasTest PM Certification Overview

The FasTest PM process includes a sequence of maintenance checks that
need to be performed annually on the Sapphire infusion pump. The FasTest
PM procedures are briefly described in the following table.

The five stages of testing are:

Number of Testing Stage  Name of Testing Stage

A W N -

Getting Started

Prime

Air Detector & Accuracy
Occlusion Sensor

Results

Each station in the navigation pane corresponds to a pump (see Figure 4.6).

Stations that are not configured are disabled and appear in gray
Stations that are configured but have no pump connected to them
appear in blue

Stations that are configured and have a pump connected to them appear
in blue with the icon "Connected" next to them.
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Figure 4.6. Station Status

Q
SAPPHIRE FasTest PM
> Station 1

N@E @6

| Helg™Avout | Setdp | Ciose 'l
(Logout)

Please read the information in the Service Manual before

> ion - "
Statio f operating this software.
1 2 4) (5
I |
> Station 3
N6 G @D @ To conduct the process, follow the steps below:
i > Station 4 connected 1 Verify you have all the needed equipment for the certification

DARQAC 2 Configure stations to available COM pons.

3 Tum pump(s) ON and connect to computer.
4 Onthe Navigation Pane choose 1 or more
“connected pump(s)” by double clicking the station.

Start the process by double clicking on a station with a
connected pump, on the Navigation Pane.

FasTest PM Calibration Verification Process

The heart of the FasTest PM process is the calibration verification, which is
made up of the following set of tests:

®  Air Detection

®  Flow Accuracy

®  Occlusion Sensing

To facilitate the testing process, Q Core has developed a special testing
application. The software application provides step-by-step testing
instructions with a summarized version of the same instructions displayed on
the pump itself. The application allows you to simultaneously test up to eight

pumps, using a USB to 4-port serial RS232 adapter, which can be purchased
separately from Q Core.
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FasTest PM Certification Kit

The FasTest PM Kit is a pre-packaged kit provided by Q Core that contains all
the special equipment necessary for performing certification testing. One kit
can be used for testing up to 30 pumps. The FasTest PM Kit is designed to be
used in conjunction with Q Core’s FasTest PM Software. Testing with the
software application is initiated by scanning the barcode of the Kit (found on
the Directions for Use).

o Q Core Medical has access to Event Log information and
may use it for purposes such as back up, research, and
statistical analysis. However, Q Core Medical does not
collect, save, or disclose any personally identifiable
information.

Kit Components

The components of the FasTest PM Kit are shown in the following illustrations.
All components of the kit are listed and described in the table preceding the
figures.

Component Description Used for

Administration set 1800 mm tubing, with (i) spike, All tests
(i) Syringe (iii) back check valve
(iv) Y-connector (v) T-connector
(vi) administration cassette,
(vii) slide clamp, (viii) Sleeve,
(ix) Fluid bag cap
(See Figure 4.7)

Fluid bag Plastic bag that can hold up to All tests
500 mL (See Figure 4.8).
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Figure 4.7. Administration Set

ix. Fluid bag cap

viii. Sleeve “
vii. Slide clamp |
vi. Administration

Cassette

V. T—connector—l

iv. Y-connector ——1"

iii. Back Check—l%

valve

ii. Syringe —
i. Spike

Figure 4.8. Fluid Bag

4*DIRS Wy

Kit Barcode
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FasTest PM Certification Software

> To install the FasTest PM software:

1.

Download the FasTest PM Setup file (.exe file) from the Q Core Medical
FTP site to a directory of your choice.

Double-click the FasTest PM Setup file to start the installation process;
then, click Next.

Review the license agreement details, and select the relevant checkbox
to accept.

To create a shortcut to the FasTest PM software, select/unselect the
relevant checkbox as desired.

Click Install.

After the installation process is completed, click Finish.

o In order to install the SW together with RS232 driver, it is
reugired to execute the “FasTest PM Setup.exe” as an
administrator — from the cmd line.
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FasTest PM Certification Test

Overview

The following sections explain how to perform the required FasTest PM tests
using Q Core’s software application:

Getting StArted ....u.eeiniiiee e 105
Performing the Prime STEP ..ovvuiiiii e e e e 111
Performing the Air Detector & Accuracy ProCess ...........cceeeevveeeeeiieervinneennen. 114
Performing the Occlusion SENSOr TESt ......vevvniiiiiiieeiie e, 117
VIEWING RESUIES ovneeii et e e 143
o The descriptions in this section elaborate on the directions

in the software application.

The FasTest PM tests are designed in a way that each action

& is required in order to set the pump to a specific condition
required for the tests. Follow each instruction fully in order to
perform the tests adequately.

Getting Started

The following sections describe how to prepare the testing environment and
begin the testing process.

Required Materials

The following equipment is required to perform the FasTest PM procedure:

105

Q Core FasTest PM Kit(s).

At least 100 mL water for each kit (the infusion bag is supplied with the
kit).
RS232 COM ports, or Serial on USB (optional).

Motorola LS2008 barcode reader (optional); you may enter the barcode
key manually instead.

RS232 communication cable between pump and computer.
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Before beginning the tests, make sure that the FasTest PM
Kits contain all the original parts supplied by Q Core (Kit
Components on page 128).

Testing Conditions

The following environmental conditions should be met during testing to help
ensure accurate results. Deviation from the environmental conditions might
affect the accuracy of the tests.

Room temperature: 20° C + 5° C

Relative humidity: up to 70%

Pump position: straight and vertical

Tubes are not kinked, and the clamp is set to open.

The required distance between the center of the pump and the bottom of
water level in the bag is 50 cm above the pump (page 110).
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Launching the FasTest PM Process

> To perform the Setup Sequence:

Carry out the following setup sequence for all the devices prior to connecting
the pumps to the PC and starting the FasTest PM test.

1. Set pump authorization level to High.

2. Select Options >Pump Configuration >General settings
- Authorization level and select High. Press Next and then OK.

o After clicking a station to start the test, if the pump is not set
to High Authorization level, a stating to set the pump to
High Authorization level will appear on screen.

> To begin the testing process:

1. Log in to the Q Core FasTest PM Software (Logging In on page 87).

o If this is the first time you run this program, you need to
configure your stations and COM ports first. Verify that the
driver has been installed successfully. The FasTest PM
software automatically recognizes the ports that successfully
connected to the pumps (See Working with the Station
Pane on page 90.)

2. Using the RS232 connector cable, connect each pump to the computer,
and turn the pump(s) on.

3. Select a station (pump) by double clicking its slot on the Navigation Pane.
> To perform the Preliminary Steps:

1. Visually inspect the station to verify that all the parts have been correctly
installed and connected.

2. Perform the preliminary inspection of the pump, according to To perform
the Preliminary Inspections: on page 92, and fill the Preliminary Inspections
result via the FasTest PM Software.

o By clicking Next, the user who is logged in confirms to be
the one who performed the inspections tests.
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> To perform the Kit Selection:

1. Using the barcode reader (or the keyboard), enter the barcode number of
the FasTest PM Kit and verify that the barcode number has 7 characters,
and that the PC language is set to English (some characters, such as “/"”
will be translated and will not reflect the actual serial number of the kit).
The barcode can be found on the Directions for Use. The same barcode is
also located on the fluid bag.

After entering (or scanning) the barcode number, it appears in the Kit
Serial Number field.

o After the certification test is completed on the pump, the
user can press the Reuse Barcode button to reuse the kit's
7-character barcode for running the FasTest PM on the next
pump, without needing to rescan or retype the barcode.
Closing the FasTest PM Software will cancel this function,
and require the user to re-enter (or rescan) the barcode.

Figure 4.9. The Reuse Barcode Button
Q Core Medical FasTest PM - [SN 300135347) |

SAPPHIRE FasTest PM et :
> Station 1 . .
@@ Getting Started (SN 300135347):
> station 2 Kit Selection
Vv Station 3 Scan barcode on the Direction For Use (DFU)
2 prime [
2 Air Detector & Accuracy
4 Occlusion Sensor @
£ Results
> Station 4 Pump Information: 300135347

Last certification:  26/1/2020

Next certification

Battery Information:

Expiry date:

Charge cycles: 1.8 /500 @

Performing Pump Certification Test 108



Figure 4.10.  Battery information on the Kit selection screen
8 Q Core Medical FasTest - [N

@
OCQRE FasTest PM

> Station 1
NE @@ e Getting Started (SN 300125542):
~ Station 2 Kit Selection

2 Prime

Scan the barcode on the Directions for Use found within the kit

Air Detector & Accuracy

< Occlusion Sensor VS$51IT Check
5 Results
29/30 Uses left for kit
> Station 3
NE G @G
» Station 4 Pump Information: 300125542

a2 @ e Last certification:  Failed

Next certification:

Battery Information:

Expiry date: 26/11/2018 (347 Days overdue)

Charge cycles: 2.8 /500

Start certification

The battery information contains:

* Expiry date displays the expiry date and number of days left to or
overdue from that date.

® Charge cycles displayed as "x / 500".

One charging cycle is defined as the cycle of the battery charging from
depletion to full charge. Partial cycle is defined as the fraction of a full
cycle.

2. Click Check. The Q Core server checks the validity of the kit.

o The kit is limited to 30 uses. Save the DFU for further eligible
uses of the kit.

3. To start the first stage (Prime), click Start certification.
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a.

. Insert the administration

Set up the FasTest PM according to
the following instructions:

Insert the administration set
spike into the bottom of the
bag.

Fill the bag with water (>100
mL) and close the cap.

Hang the bag on an IV pole.
Position the pump on the Mini
Cradle in an upright vertical
position, and make sure it is
turned on.

cassette into the pump and

close the door.

Adjust the bag height so that

the water level in the bag is L
50 cm above the pump.

During the test, it is recommended to connect the pump to a power supply.

o When the pump is connected to a power supply, the battery

icon (on the pump indication bar) displays one bar, although
the pump is recharging. The indication for the pump being
charged can be obtain via the "Charge" LED on the pump.

5. On the pump, press Next to proceed to the Prime step.

Certification [ Sapphire 11 ]

Setup instructions
On PC

Next
L_/
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For each of the tests (Air Detector & Accuracy and Occlusion Sensor) there are
two retries available. Failing the two retries on any of these tests counts the
entire certification test, and renders it FAILED. Operational errors, such as
forgetting to insert air or clamping the set, will not be counted as retries. Each
kit is limited to 30 certification tests.

At any stage of the test, the user may re-start it, by pressing on the "Stop"
hard key below the pump screen, or the "Quit" button on the pump screen.
The test returns to the "Prime” step — stopped tests will not be counted as
retries.

Performing the Prime Step

This is an optional stage. It is necessary only in the
following cases:

®  When using a new FasTest PM Kit

®  The upstream segment between the spike (A) and
the bottom of the administration cassette (B)
contains air.

When certifying subsequent pumps, priming is not

required — as long as the upstream segment of the set is

primed.

o Note that as of this stage, the procedure is operated via the
pump.
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Figure 4.11. Priming Screen

Q Core Medical FasTest PM - [SN 300135347)

K3 I o
> Station 1 -
NOEOE Prime (SN 300135347):
> Station 2 Ve rify
NEE®6
v Station 3
1! Getting Started 1 Choose the relevant option:

1.1 the administration set is primed, press “Next”

31 Air Detector &Accuracy
[to proceed to Air Detector & Accuracy test]

41 Occlusion Sensor
5 Results 2.1f the administration set is not primed, press “Prime”
[to proceed to set priming]
> Station 4

NEEEE

> To perform Priming:
1. Prepare the infusion bag and the administration set:

a. Fill the bag with at least 100 mL of tap water, and attach the
administration set to the bag.

b. Adjust the bag height, so that the water level in the bag is 50 cm
above the pump.

c. Attach the administration set to the pump, and close the safety door.
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2. If required, press Prime.

o The priming process can be finished at any time by pressing
Finish Prime. This option can be used if the user observes
that there is no air in the tube (between the spike and the
bottom of the administration cassette — see page 111).

If not required, press Next.

Certification [ Sepphire [i ] Certification [ Sapphire [+ |

Prime Prime
Choose the relevant option:
1. If the administration set is primed,

press ‘Next' [to proceed to Air

Detector & Accuracy test] Processing

2. If the administration set is not
primed, press 'Prime’ [to proceed to
set priming]

Wait for the pump and software to synchronize.

? »)

Synchronizing...

3. Press "Next" to proceed to the Air Detector & Accuracy test.
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Performing the Air Detector & Accuracy Process

This test involves introducing a pre-specifiied amount of air into the
administration set.

The application checks if the pump detected air in the system, and whether
the measured infused volume is correct (checks it versus the expected
volume).

> To perform the Air Detector & Accuracy test:

1. Continuing from the previous stage, without disconnecting the syringe,
pull the plunger back all the way to the 1.5 mL stopper; then, push in all
the way to the Y-connector (Figure 4.12 on page 114).

Figure 4.12.  Air Detector Test

Q Core Medical FasTest PM - [SN 300153595]

Q
SATPHIRE FasTest PM
> Station 1

> Station 2 connected Test

3 @@
® Station 3 ( S ¥ | A Pull the plunger “back”
e ; ] b - B
2 1 s | tofill the syringe with air.
 Station 4 [, 4 B. Push the plunger to inject all air
/ amount into the administration set.
1 Getting Started e S Note: Keep the syringe
2 prime connected throughout the tests.
* Do not perform these steps
4 Occlusion Sensor / PR
5 Results A B

Press “Start”
[to start the test]

Syringe plunger head ‘{

stopped at 1.5 mL f\ AN
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2. This inserts 1.5 mL of air into the administration set, via the Y-connector;
then, on the pump, press Start.

Certification [ Sapphire i |

Air Detector &

Accuracy Test
A Pull the plunger ‘back’ to fill the
syringe with air.
B. Push the plunger to inject all air
amount into the administration set.

* Note: Keep the syringe connected
throughout the tests.

Press ‘Start’ [to start the test]

The pump starts delivering the water. When the stage is completed, the
pump stops.
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If a fault was detected, an error message is displayed with recommended
corrective actions (see example below).

'# Q Core Medical FasTest - [SI
@ & purmp | Hs\{ﬂhnut "Setip | CloseNd

acgre FasTest PM /Heto, Tester,  (Lagou)
> Station 1

nEeae Air Detector & Flow Accuracy (SN 300125542):
~ Station 2 Test

* Getting Started

-

2 Prime

4 Occlusion Sensor

5 Results

> Station 3

OO G G Detected air exceeded the expected amount.

> Station 4 Verify that:
The set is properly primed.

nNEGEGOE

~

There are no stuck bubbles inside the cassette tube
If exist- remove the cassefte and flick'it. Flush the
stuck bubbles by priming the set manually.

If all conditions are met, press Restart on the pump.

3. To proceed to the next test (Occlusion Sensor), on the pump, press Next.

Certification [ Sapphire [

Air Detector &

Accuracy: Finish
Air Detector & Accuracy test is
complete.

Press 'Next' [to proceed to
Occlusion Sensor test]
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Performing the Occlusion Sensor Test

This test involves delivering a known volume of fluid; then, creating pressure
in the system — caused by introducing a specific amount of air into the
administration set against a closed clamp.

> To perform the Occlusion Sensor test:

1. Set the administration clamp to CLOSED (clamp the administration set).

During the FasTest PM process, do not remove the
A administration cassette from the pump.

Figure 4.13.  Operating the Clamp

OPEN (Unclamped) CLOSED (Clamped)

2. On the pump, press Start.
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3. When the test is completed, set the administration clamp to OPEN
(unclamp the administration set); then, on the pump, press Next.

11 Q Core MedicalFasTest PM - N 300135347) = W

- D | Helf*PAbout |‘Setdp | cms;y

SAPPHIRE FasTest PM * (Logou
> Station 1
POOOE Occlusion Sensor (SN 300135347):

> Station 2 Test

v Station 3
1" Getting Started
2 prime

31 Air Detector & Accuracy

5 Results

>
Station 4 0 Unclamp the administration set.

e S € On pump press “Next".

4. On the pump, press Next.

Viewing Results

1. To complete the certification testing process and generate results, on the
pump, press Finish.

When certification testing is finished, a certification report is automatically
generated and displayed on the computer monitor. The report includes the
following information:

®  The field Device SW version displays the pump software version. Verify
the pump software matches the pump type. For example, make sure All
modes software designated for Multi Therapy pumps is not installed on
an Epidural pump (yellow Lexan). Upgrade the software if applicable to
ensure the correct software is installed on the pump per latest Labeling
and Software Revision Table, 15000-004-0002-SM or Labeling & SW
Revisions Table for Q Core Service Providers, 15000-004-0003-SM.

®  The Occlusion sensor test and Accuracy test results are displayed on
scales
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The Occlusion sensor test result is displayed on a scale in Bar units. An
arrow and a number below it indicate the result. Any result within the
limits is defined as "Pass" (see Figure 4.14).

The Accuracy test result is displayed on a scale in percentage. An arrow
and a number below it indicate the result. Any result within the limits is
defined as "Pass" (see Figure 4.14).

The certification can be printed or saved on the computer in soft copy
(see icons on the top right corner in the figure below). When pressing the
save icon, wait for the dialog box to appear and select the desired
destination of the saved file.

o The Next certification date in the pump's View system menu
will be updated after the pump has been operating for one
second (That is, one second of treatment or of priming).

Figure 4.14.  FasTest PM Results — Passed

Q Core Medical FasTest PM - [SN 30013534

@ p | Helf™ About | ‘Setup | Close 'l
SAPPHIRE FasTest PM 1
> Station 1
NOE@E SN 300135347:
> Station 2 Results
1 2 3 4 5
@ 8
v Station 3 N
1 Getng tared SAPPHIRE
® prime FasTest PM Certificate
3. Air Detector & Accuracy
4 Occlusion Sensor Thisis to confirm that device (S/N) 300135347
successfuly passed the FasTest PM test.
» Station 4 This certification is valid until:18-Feb-2021 !
NEGGE I
Manufacturer: Q Core Medical Ltd. Tests included:
Devica SW version: 13.23.02 Visual inspection: Pass
T Safaty faatures tast: Pass:
23 2
e 04-FaD-2020 Accuracy test: Pass. t----—--—n-'c';;-'l Bl
Technician name:  Eran Eitan Alr Detector test; Pass

o0 or
Occlusion Sensor test: Pass  #=seesshuremamencg [bar]
o

g
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For the certification process to be successful, you must have the Preliminary
Inspections confirmed and the pump passed all 3 tests. The report can be
printed for further records. After printing, close the test's screen on the PC.

In case of failure in the Preliminary Inspections, the reason(s) for the failure will
be either one (or both) of the following (see Figure 4.15):

® Visual inspection

®  Functional inspection

Figure 4.15.  FasTest PM Results — Failure

I Q Core Medical FasTest PM -

~ ‘
SA%FE FasTest P m?(‘u:;l,fbm |"setup | CloseN
> Station 1 '
DO O G GC SN 300135347
> Station 2 Results

|‘ v Station 3
1 Getting Started

Prime

Air Detector & Accuracy

Occlusion Sensor

> Station 4

N@E

PUMP HAS FAILED THE FASTEST PM TESTING. |
I! PLEASE RETURN PUMP FOR SERVICE. |

‘ Pump S/N: 300135347
Kit SIN:
Failed test(s): Visual inspection
Functional inspection [

In case of failure in the calibration verification tests, the reason(s) for the failure
will be one (or more) of the following (see figure below):

e (QOcclusion Sensor
e  Air Detector

®  Flow Accuracy
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Only the results of failed tests will be displayed. If the Occlusion sensor test or
the Accuracy test fails, the arrow and the number below it will be displayed
outside the scale, on the relevant side of it (see figure below).

Figure 4.16.  FasTest PM Failure — Calibration Verification

] Q Core Medical FasTest PM - [SN 300135347)

- ° - o w ol s
N
SAPPHIRE FasTest PM
> Station 1
DaEa e SN 300135347:
> Station 2 Results |
v Station 3 |
1 Gelting Started
2 Prime

3 Air Detector & Accuracy

4 Occlusion Sensor

> Station 4
DNOO@E

PUMP HAS FAILED THE FASTEST PM TESTING.
PLEASE RETURN PUMP FOR SERVICE.

Pump SIN: 300135347
Kit S/N: 85UTYK2

Failed test(s): Air Detector & Accuracy test

g Please note that failed pumps have to be returned for
service.
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FasTest PM - Following the Certification

After the device passes the FasTest PM test, verify the following:

® The date and time are set to local date and time. Adjust as necessary.

® The new FasTest PM date is more than 1 year from present date. The
annual certification record can be printed if required before clicking

"close" on the PC window. Once the window is closed, printing is
unavailable.

0 The next certification date may be inaccurate when the
pump is checked right after passing FasTest PM. This date
will be updated to +380 days when the pump is put to use.

Disconnect the pump from the FasTest PM software.

In case the FasTest PM terminated unexpectedly, or pump became
disconnected during the test, make sure the following pump parameters are
set as required:

e  Accumulated Bubble Size
e Single Bubble Size
e  Accumulated Threshold

In the event that the FasTest PM terminates unexpectedly, it is recommended
to set the pump to factory defaults.

From the toolbar of the Start Up screen, press Options = Technician options
- Pump settings - Reset system — Factory defaults.

o In REV 14.50.0 after test completion, the pump displays the
"Infusion completed" screen, and not the Main screen
("New Infusion screen")
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FasTest PM Troubleshooting

The following sections explain how to troubleshoot common problems that
may arise while performing the FasTest PM certification process:

COMMUNICATION L.eiiiiiiiie e et e eee e e eeees 93
Login and Kit ENTIY .ouoieeeiiiiiiie e e e e e et e e s e e e e 94
Air Detector & FIOW ACCUraCy TEST ...ivuiiiniiiieeiieeieeeiceeie et 123
OCClUSION SENSOT TEST veiiiiiireeiitiiiiie ettt etiiiee e eeettiiee s e eeeeebieeeeereabaeeeeeeeees 124
FasTESt PIM GENEIAl ....iiiiiiiiie ettt e s 125

Air Detector & Flow Accuracy Test

The following issues can arise during the Air Detector & Flow test:

Problem Management

Occlusion alarm alert appears ~ Verify that the administration clamp is set to
during the Air Detector & Flow ~ OPEN; then, perform Reset of the Test (see

Accuracy test. Occlusion Sensor Test on page 124).

The user forgot to introduce Repeat the Air Detector & Flow Accuracy Test.

air into the set. Pay attention to follow the instructions as they are
displayed.

Air could not be detected by Verify the following:
the Air Detector. 1. Air has been appropriately inserted to the set.
2. Cassette chamber is clean.

To verify cassette chamber is clean:

a. Remove the administration cassette from
the pump.

b. Verify that the light sensor, located above
the pump fingers in the cassette chamber,
is clean. (Figure 3.4 on page 51). To clean,
see Chapter 3: Maintenance and Storage on
page 42.

c. Reinsert the administration cassette.
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Problem Management

Detected air exceeded the Check the following:
expected amount. 1. The set is properly primed.
2. There are no stuck bubbles inside the cassette
tube. If there are, remove the cassette and
"flick" it. Flush the stuck bubbles by priming
the set manually:
a. Remove the administration cassette from
the pump.
b. Open the Anti Free Flow Valve (AFFV) on
the administration cassette.
c. Prime the set. Make sure that all air has
been removed.
Accuracy could not be verified.  Verify the following:
1. The set is properly primed.
2. The fluid bag is not empty.
3. There are no kinks along the administration set.

Occlusion Sensor Test

The following issues can arise during the Occlusion Sensor test:

Problem Management

Reset of the Test. At any failure of the Occlusion Test, repeat the
Air Detector Test and/or the Flow Accuracy
Test, as detailed by the FasTest PM software.

An error message appears. Perform Reset of the Test.

Testwas performed incorrectly, ~ Perform Reset of the Test.
and needs to be restarted.

Occlusion sensor could not Verify the following:
detect the expected increase 1. The administration set is not damaged.
In pressure. 2. The administration set was clamped.
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FasTest PM General

o For issues common to both ACT and FasTest, see also
General on page 95

The following are general issues that can arise during certification testing:

Problem

Unauthorized Pump message

appears.

The FasTest PM software stops

during the test.

The certificate printing process

failed; information is printed
without the certificate image
background.

During the FasTest PM
installation, the following is
prompted: "This application
requires .NET Framework 4.0
full, please install the .NET
Framework and then run the
installer again."

Error message: "Battery
Issue”.

125

Management

The pump is running a software that is not rev. 15.
Upgrade the software — contact the support team
for further instructions.

Re-start the FasTest PM software and begin the
test from the start.

Perform one of the following options:

1. Go to the service portal https://
service.qcore.com/; and search for the Device;
then, from the Maintenance tab, download
the certificate.

2. Provide the pump S/N and certification date to
service@qcore.com and the certificate will be
emailed to you.

3. Use the "print screen" option and copy the
certificate image to a suitable application to
print.

® Click OK to cancel the installation.

® On the computer: Go to Start ~All

Programs ~»Windows Update.
® Select Optional Updates and then select .NET
Framework 4.0.

® Follow the online instructions to complete the

update.

® Double-click the FasTest PM Setup file to start

the installation again.

Contact Q Core Service department for more
information.
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Problem Management

Test failure. ® Check the administration set, to see if there are
any residues in the water. If there are visible
residues, replace with fresh water.

® Check if the clamp area is occluded. If it is,
replace the set.
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Annual Certification Test (ACT) Method

The following sections detail the Annual Certification Test (ACT) process for
the Sapphire pump:

ACT Calibration Verification ProCeSs .......uuevviieiiiiiiereeiiiiiiieeeeeeiiiieeeeeeeeiiinens 127
SYStEM REQUIFEMENTS ouiieiiiiiieiie e e e e ee e e e e e e eae et eaneanas 86
Y Ol I Q) RN 128
ACT SOFEWAIE eiiiiieeeeeeiiieee ettt e e ettt s e et et et e e e e eeetbe s e e eaansaannss 131
ACT Certification TESTS ..iivueiiiiieieiiie ettt e e e e e e eaee 133
ACT TroubleshOOting .....couueiiiiiiiei e 148

ACT Calibration Verification Process

The heart of the annual certification process is the calibration verification
which is made up of the following set of tests:

e  (QOcclusion Sensor
®  Air Detector
®  Flow Accuracy

To facilitate the testing process, Q Core has developed a special testing kit
referred to as "Annual Certification Kit" which supplies special tools necessary
for testing 5 pumps. The kit is used with the Annual Certification Software. It
enables you to perform testing with the pump connected to your PC and to
receive immediate testing feedback via the Q Core server.

The software application provides step-by-step testing instructions with a
summary version of the same instructions inscribed on the pump itself. The
application allows you to test simultaneously 1-8 pumps, using a USB to
4-port serial RS232 adapter which can be purchased separately from Q Core.

o A test can be simultaneously performed on up to 8 pumps.
The tools provided in Annual Certification Kit can be used
for 5 pumps, and only one pump at a time.
To test multiple pumps simultaneously, prepare number of
kits as the number of pumps that will be tested.
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ACT Kit

The Annual Certification Kit is a pre-packaged kit provided by Q Core, which
contains all the special equipment necessary for performing certification
testing. One kit can be used for testing 5 pumps. The Annual Certification Kit
is designed to be used in conjunction with Q Core’s Annual Certification
Software. Testing with the software application is initiated by scanning the
barcode of the Kit (found on the Directions for Use).

Kit Components

The components of the Annual Certification Kit are shown in the following
illustrations. All components of the kit are listed and described in the table
preceding the figures.

Component Description Used for

Administration set 1.5 meter tubing including 3 All tests
markings, with (i) spike, (ii)
Y-connector, (i) administration
cassette, and (iv) male luer lock.
(See Figure 4.17)
Extension set 5-8 cm tubing, with female luer Occlusion Sensor test

lock and check valve (with
female luer lock). (See Figure

4.18)
Syringe 5 mL (no needle). (See Figure Occlusion Sensor and
4.19) Air Detector tests
Flow Accuracy Two bottles of 120 mL; one Flow Accuracy test
Container plastic cap, with (i) a metal

hanger, (i) a male luer lock port
and (iii) a female luer lock port
with a leading tube. (See Figure
4.20 and Figure 4.21)

Hydrophobic filters (6) 3 micron hydrophobic filter. Flow Accuracy test
Note: Only 5 are (See Figure 4.22)

required; one extra is

included.
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Figure 4.17.  Administration Set

Spike |
Administration ‘ i =4
cassette g —
Female luer
lock
Y-connector . \ S
Markings — ===
g The administration set used in the Annual Certification
Process is not for human use. Do not use this Administration

Set for any other purpose.

Figure 4.18. Extension Set

a
il Q'.
‘Ei \
|

Figure 4.19.  Syringe

oA i e e T
S,

i et e o\
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Figure 4.20.  Flow Accuracy Container

120ml plastic
bottle

Figure 4.21.  Flow Accuracy Container: cap

Male luer lock

Female luer lock,
with a leading tube
(not shown)

Metal hanger
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Figure 4.22. Hydrophobic filter (6)

ACT Software

Q Core's Annual Certification Software streamlines the Annual Certification
process by enabling you to test the pump while communicating with the Q
Core server. Step-by-step instructions are provided onscreen (PC and Pump
screens), and results are printed immediately following the testing process.

The following topics are covered:

System ReQUIFEMENTS ..cieiiiiiii ittt eeee e e s ee et e e eanaan 86
ACT Software Installation ProCESS .......cuuuuireieiriiiiieieereeiiireeeeeeriieeeeeeennnnnnss 131
B L) - 1AL o T - [ TN 132
Getling StArted ..ovvvniiiii i e e e eaa e 134
Performing the Air Detector TSt .....ccvveiiiiiieeeiiiee e 141
Performing the FIOw ACCUracy TESt .....ueiiuiiiiiiiiiiiie e 141

ACT Software Installation Process

1. Download the setup file ACT Setup (.msi or .exe file) from the Q Core
Medical FTP site to a directory of your choice.

2. Double-click the ACT Setup file to start the installation process and click
Next.

3. Review the license agreement details and check the relevant checkbox to
accept.

4.  To create a shortcut to the ACT software check/uncheck the relevant
checkbox, as desired.
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5. Click Install.

6. After the installation is completed click Finish.

The Station Pane

The five stages of testing (listed 1-5 on the pane) are:

Number of Testing Stage  Name of Testing Stage

1 Getting Started
2 Occlusion Sensor
3 Air Detector

4 Flow Accuracy

5 Results

Each station in the navigation pane corresponds to a pump (see figure below).
®  Stations that are not configured are disabled and appear in gray

®  Stations that are configured but have no pump connected to them
appear in blue

®  Stations that are configured and have a pump connected to them appear
in blue with the icon "Connected" next to them.
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Figure 4.23.  Station Status

@
QCORE ANNUAL CERTIFICATION

> Station 1 connectea

DNOOO®E
Please read the information in the Service Manual before

> ;
Station 2. comecten operating this software.

DNOOOE

> Station 3 connectea

G O O G To conduct the process, follow the steps below:

> Station 4 connected 1 Verify you have all the needed equipment for the certification.
pEeoe 2  Configure stations to available COM ports.

> Station 5 comnectea 3 Tum pump(s) ON and connect to computer (7)) (
S 4 Start the process by double clicking on an active station

> Station & Connected on the Navigation Pane.

DNEOORE
> Station 7

DNEOQOE

> Station 8

afafalalc

ACT Certification Tests

The following sections explain how to perform the required Annual
Certification Tests (ACT) using Q Core’s software application:

Getting Started .....eiie i
Performing the Occlusion SENSOr TESt .....uveevniiiiiiiieiiie e,
Performing the Air Detector TESt .....ccvviiiiiieeeiiiie e e e e
Performing the FIow Accuracy TSt ......ccoiiveiiiiiiiiiiiieeiice e

VIEWING RESUIES 1oveniiiiiiiii e e et e e

o The descriptions in this section elaborate on the directions in
the software application.

The annual certification tests are designed in a way that each

&3 action is required in order to set the pump to a specific
condition required for the tests. Follow each instruction fully
in order to perform the tests adequately.
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Getting Started

The following sections describe how to prepare the testing environment and
begin the testing process.

Required Materials

The following equipment is required for certification testing:
e Q Core Annual Certification Kit(s).

® Aninfusion bag that is filled with at least 200 mL fluid - the bag should be
a collapsible bag of water.

® RS232 COM ports, or Serial on USB (optional).

®  Motorola LS2008 barcode reader (optional); you may use the barcode key
manually instead.

® RS232 communication cable between pump and computer.

Before beginning the tests, make sure that the Annual
Certification Kits contain all the original parts supplied by Q
Core (Kit Components on page 128).

Testing Conditions

The following environmental conditions should be met during testing to help
ensure accurate results. Deviation from the environmental conditions might
affect the accuracy of the tests.

*  Approximate time of the test (per pump) is 15 minutes; verify that your
computer has adequate power supply to last for the duration of the test.

® Room temperature: 20°C + 5° C
® Relative humidity: up to 70%
®  Pump position: straight and vertical

*  The required distance between the center of the pump and the bottom of
the bag is 50 cm (Figure 4.24).

® The required distance between the center of the pump and the bottom of
the container cap is 0 =10 cm (Figure 4.24).
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Figure 4.24.  Station setup
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Launching the Annual Certification Process

> To perform the Setup Sequence:
Carry out the following setup sequence for all the devices prior to connecting
the pumps to the PC and starting the Annual Certification test.

o If the pumps were already connected to the PC, disconnect
all the devices from the COM ports and wait for 30 seconds
before performing the setup sequence.

o The Annual Certification software uses Continuous delivery
mode for the tests, even if this mode is not configured on

the Sapphire pump. When the certification tests are finished,
make sure that the pump is at an allowed delivery mode.
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1. In software versions that support the disabling of Air detection:

a. If the Air Detection disabled icon,@, appears on the indicators bar,
enable the Air Detection (On). If pump is connected to mini cradle,
disconnect it from mini cradle Select: Options ~>Technician options
—>Pump settings —Set air detector ~>Air Detection. Toggle the
setting to On and press OK.

b. For Epidural Devices, this icon [l@g] will not be displayed if air detectors
are disabled. The air detectors are disabled if both Single Air Detector
and Accumulated Threshold are set to OFF. To turn air detector on
change the Accumulated Threshold to 1 mL disconnect pump from
mini cradle. Options —Technician options >Pump settings —Air
Detector ~>Accumulated Threshold and select 1 mL. If the device
has a drug library and both detector Single Air Detector and
Accumulated Threshold are set to OFF, disconnect pump from mini
cradle, set the Accumulated Threshold to 1 mL. These changes will be
in effect when the device is on, once device is turned off, the values
will revert back to drug library settings.

c. From the Start menu, select Options »>Pump Configuration -
General settings = Authorization level and choose High. Press Next

and then OK.
o After clicking a station to start the test, if the pump is not set
to High Authorization level, a stating to set the pump to

High Authorization level will appear on screen.

2. Perform the preliminary inspection according to To perform the Preliminary
Inspections: on page 92.

o By clicking Next, the user who is logged in confirms to be
the one who performed the inspections tests.
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> To begin the testing process:

1. Log in to the Q Core Annual Certification Software (Logging In on page 87).

o If this is the first time you run this program, you need to
configure your stations and COM ports first. Verify that the
driver installed successfully. The ACK software automatically
recognizes the ports that successfully connected to the
pumps (See Working with the Station Pane on page 90.)

2. Using the RS232 connector cable, connect each pump to the computer,
and turn the pump(s) on.

3. Select a station by double clicking on its slot on the Navigation Pane.

> To perform the Kit Selection:
1. Using the barcode reader (or the keyboard), enter the barcode number of
the Annual Certification Kit and verify the following:
a. The barcode number has 28 characters
b. The barcode number starts with "+M8261..."
c. The PC language is set to English (some characters, such as “/” will be
translated and won't reflect the actual serial number of the kit).

The barcode reader can be found on the top left of the Directions for
Use, found within the kit.

After entering (or scanning), the barcode number will appears in the Kit
Serial Number field.
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Figure 4.25.  Battery information on the Kit selection screen

@ W i
ocone ANNUAL CERTIFICATION e v o el
Getting Started (SN 700014489):
Kit Selection
¥ Station 3 Scan the barcode on the Directions for Use found within the kit ()

2 Occlusion Sensor
31 Alr Detector
4 Flow Accuracy

% Results

Pump Information: 700014489

Last certification:  17/2/2015

Next certification:  3/3/2016

Battery Information:

Expiry date:  2/8/2017 (432 Days)

73 1500 @

Charge cycles:

The battery information includes:

® Battery expiry date.

® Charge cycles displayed as "x / 500".

One charging cycle is defined as the cycle of the battery charging from
depletion to full charge.

2. Click Check. The Q Core server checks the validity of the kit.

0 The kit is limited to 5 uses. Save the DFU for further eligible
uses of the kit.
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If the kit has not been fully used, a message appears listing the number of
uses remaining. If the number of uses is exhausted or the kit is otherwise
invalid, an appropriate error message appears.

o Ensure that all parts of an old kit are disposed of before
using a new kit. Parts from an old kit should not be used
under another kit number.

Use of the kit is deducted from the eligible uses once the results of the
tests are sent to Q Core.

Exiting the tests in the middle of the process will not deduct

A the number of uses remaining. However, you will have to
start the process from the beginning. Results are not saved if
you exit the process in the middle.

3. To start the first test (Occlusion Sensor), click Start certification.

Performing the Occlusion Sensor Test

This test involves creating pressure in the system by introducing specific
amounts of air into the administration set, against a check valve. The air is
inserted in a 3-step process.

> To perform the Occlusion Sensor test:

1. Prepare the infusion bag and the administration set:

a. Fill the bag with at least 200 mL of tap water, and attach the
administration set to the bag.

b. Attach the administration set to the pump, and close the safety door.

2. Perform automatic priming on the pump, press Prime.

g For this test, automatic priming is required. Do not prime the
administration set manually.

During the Occlusion Sensor Test (Prime, Setup and Test), do
A not remove the administration cassette from the pump.

139 Sapphire Infusion Pump Service Manual



3. Verify effectiveness of the prime by visually inspecting the administration
set and checking for air.

If any air is present, on the pump, press Prime. Repeat automatic priming
until the set is completely free of air.

When the administration set is fully primed, on the pump, press Next.

5. Attach the extension set to the administration set, with the check valve at
the free end (Figure 4.18 on page 129); then, fill the syringe with air, and
connect it to the check valve at the free end of the extension set.

6. On the pump, press Next.

o Steps 7-9 need to be completed within 30 seconds.
Be exact in applying airl
To start the test over for any reason, on the toolbar of the
pump, press Restart.

/. Using the syringe, insert air into the administration set until the air
reaches the first mark on the tubing (Figure 4.17 on page 129). Then, on
the pump, press Mark 1.

8. Insert more air into the administration set, until the air reaches the second
mark on the tubing. Then, on the pump, press Mark 2.

9. Insert more air into the administration set, until the air reaches the third
mark on the tubing. Then, on the pump, press Mark 3.

10. To proceed to the next test (Air Detector), on the pump, press Next.
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Performing the Air Detector Test

This test involves introducing air into the administration set from above the
administration cassette, and checking whether the pump detects air in the
system.

> To perform the Air Detector test:

1. Remove the syringe from the extension set and then remove the
extension set from the administration set.

2. Connect the syringeto the Y-connector (Figure 4.17 on page 129). Using
the syringe, insert 1 mL of air into the administration set, via the
Y-connector and disconnect the syringe. Then, on the pump, press Start.

Infusion of fluid starts, and then (when the air is detected) stops.

3. To proceed to the next test (Flow Accuracy), on the pump, press Next.

Performing the Flow Accuracy Test

This test involves infusing a specific amount of fluid into a container, and
checking whether the pump measures the correct volume infused.

A Prior to starting the test verify fluid container is completely
dry. The kit is provided with two bottles in order to ensure
that at least one of the bottles is dry at any given time.
Starting the test with all components dry is critical to the
success of the certification testing.

> To perform the Flow Accuracy test:

1. With the cap removed from the Flow Accuracy Container, attach a new
hydrophobic filter to the male luer fitting on the cap of the Flow Accuracy
Container. Do not reuse hydrophobic filters.

Then, attach the end of the administration set to the female luer fitting.
When finished, press Next on the pump.

2. Prime the administration set manually, as follows:

® Remove the administration cassette from the pump, and perform
manual priming by opening the AFFV on the cassette.

* Verify the set and the leading tube of the cap are flushed.
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* Avoid getting the hydrophobic filter wet.

3. Verify effectiveness of the prime by visually inspecting the administration
set and checking for air.

If any air is present, repeat priming until the set is completely free of air.

4. When the administration set is fully primed, reinsert the cassette to the
pump and close the door. Verify that all connections are tight. On the
toolbar of the pump, press Next.

A ® Keep the positioning of the fluid container vertical during
the test period.
® Once the flow accuracy container is full, the device detects
the occlusion and stops the test. Drops may seem coming
from the filter as the water in the container reaches the
top, this is normal.

5. Make sure the cap and the Flow Accuracy Container are completely dry.
Attach a completely dry container to the cap. A container from a different
kit maybe used.

o To ensure the container is completely dry, hang it upside
down for at least 10 minutes prior to use.

You may verify the container dryness by weighing the
container with a balance: the weight of a dry bottle should
not exceed 13g. Weight above this value indicates that
some water is present in the container.
Ensure the cap is dry by wiping it with a dry cloth. Verify
there is no residual fluid in the inner areas of the bottle cap.

6. Make sure the connectors on the top are fully screwed into place prior to
starting the test.
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Figure 4.26.  Flow Accuracy Container cap

10.

Make sure the container is positioned upright and in the same height of
the pump. Use the hanger on the cap if necessary.

g 10cm difference between the two is acceptable.
Larger difference can cause back pressure that will
jeopardize the credibility of the results.

Make sure the collapsible bag of water holds at least 150 mL of water.
Then, press Start on the pump.

To complete the certification testing process and generate results, press
Finish.

If the pump failed the Flow Accuracy test, perform the manual prime
again as described in step 2 before repeating the Flow Accuracy test. This
will not deduct from the number of kits available.

Viewing Results

When certification testing is finished, a PDF report is automatically generated
and displayed on the computer monitor. The report includes the following
information:
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The Occlusion sensor test and the Accuracy test results are displayed on
a scale. An arrow and a number below it indicate the result. Any result
within the limits is defined as "Pass" (see Figure 4.27).

The certification can be printed or saved on the computer in soft copy
(see icons on the top right corner in the figure below). When pressing the
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save icon, wait for the dialog box to appear and select the desired

destination of the saved file.

o The certification can also be found in the Portal.
o The Next certification date in the pump's View system menu
will be updated after the pump has been operated for one

second (That is, one second of treatment or of priming).

Figure 4.27.  ACT Results
a Q Core Medical Annual Certification - [SN 300121749] —
@ 1 p \‘Hel;ﬂbnut |“Setap | mose
QCORE ANNUAL CERTIFICATION (Logoun -
> Station 1 Connected 5
nE e E SN 300121749:
 Station 2 Results

Getting Started

Occlusion Sensor

"

Air Detector

Flow Accuracy

> Station 3 connected

ajayaXa

> Station 4

ajayalala

@

QCORE ANNUAL CERTIFICATION

This is to confirm that device (S/N) 300121749

successfully passed the annual certification test.

This certification is valid until: ~ 02-Oct-2020

Manufacturer: Q Core Medical Ltd.
Device SW version:  13.23.02

Certification kit S/N: +DebugTestiit

Test date: 18-8ep-2019
Technician name:  Tester

Tests included:

Visual Inspection: Pass

Safety foatures test: Pass.

an o
Ocelysion sensor test Pass  BevremmsnBoemenerent [037]

For the certification process to be successful, you must have the Preliminary
Inspections confirmed and the pump passed all 3 tests. After verifying that all

tests have passed, close the AnnualCertification screen on the PC.

o At the end of the ACK test, turn the pump off and

disconnect the pump from power supply and
communication cable.
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In case of failure in the Preliminary Inspections, the reason(s) for the failure will
be either one (or both) of the following (see Figure 4.28):

®  Visual inspection

®  Functional inspection

Figure 4.28.  ACT Failure — Preliminary

@ R -.'. p |‘Hm Roout | “Setup | Cioseygl
GCORE ANNUAL CERTIFICATION o, Testet  (Logout) 5
¥ Staton 1 SN 300153592:

1 Getting Started

2! Occlusion Sensor Results
3 Air Detector

< FlowAccuracy

PUMP HAS FAILED THE ANNUAL CERTIFICATION TESTING.
PLEASE RETURN PUMP FOR SERVICE.

Pump S/N: 300153592
Kit SIN:
Failed test(s): Visual inspection

Functional inspection

In case the ACT has terminated unexpectedly, the following pump parameters
may change:

e KVO in Continuous delivery mode
®  Set Prime Volume
e  Accumulated Air detector

In the event that the ACT terminates unexpectedly, we recommend that you
set the pump to factory defaults.

From the toolbar of the Start Up screen, press Options = Technician options
- Pump settings - Reset system — Factory defaults
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In case of failure in the calibration verification tests, the reason(s) for the failure
will be one (or more) of the following (see figure below):

e QOcclusion Sensor
®  Air Detector
®  Flow Accuracy

Only the results of failed tests will be displayed. If the Occlusion sensor test or
the Accuracy test fails, the arrow and the number below it will be displayed
outside the scale, on the relevant side of it (see figure below).

Figure 4.29.  ACT Failure — Calibration Verification

@
oo ANNUAL CERTIFICATION

olp | @it | sewp | Ciose
imrod Schiveizer (Logout)

> Station 1 Connected

v @ Results (SN 300111234):

v Station 2 Results

1 Getting started

2 Occlusion sensor
3 Air detector

4 Flowaccuracy

PUMP HAS FAILED THE ANNUAL CERTIFICATION TESTING.

» Station 4 Connected PLEASE RETURN PUMP FOR SERVICE.

CRNF URE R | ]
> Station 5 Connected Pump S/N: 300111234
P0G Kit S/N: +M386120500001050GRP5028
00
> Station 6 Connected Failedtest(s):  Occlusion Sensor o] [bar]
1 z 4 5
Air Detector
> Station 7 Connected .
QR ARELE O El Flow Accuracy v %l

> Station 8 Connected Close

OO@E

g Please note that failed pumps have to be returned for
service.
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ACT - Following the Certification

After the device passes the ACT test, verify the following:
® The date and time are set to local date and time. Adjust as necessary.

The new ACT date is more than 1 year from present date. The annual
certification record can be printed if required before clicking "close" on the
PC window. Once the window is closed, printing is unavailable.

o The next certification date may be inaccurate when the
pump is checked right after passing ACT. This date will be
updated to +380 days when the pump is put to use.

Disconnect the pump from the Annual Certification software.
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ACT Troubleshooting

The following sections explain how to troubleshoot common problems that

may arise while performing certification testing:

COMMUNICATION L.iiniiiiii et eens
Login and Kit ENTIY coe.ivuniii it e e aaaas
(0100 [T o] WY =T 0 1Yo ] gl [T RN
Air Detector TeST ... e
FIOW ACCUIACY TESE ouniiiniiiiiiiie e et e et e et e e e e e e e e aeeaaaas
F YO I CT=T o T=T | N

Occlusion Sensor Test

The following issues can arise during the Occlusion Sensor test:

Problem Management

Reset of the Test For any reason that the test needs to be

restarted, you must disconnect the Extension Set

first. After confirmation, the pump performs
automatically priming. Repeat the test, starting

from the Setup screen.

Test was not completed within ~ Perform Reset of the Test.
30 seconds after pressing

Mark 1on the pump. An error

message appears.

Test was performed incorrectly, ~ On the toolbar of the pump, press Restart. Then,
and needs to be restarted. to confirm, press Yes. Perform Reset of the Test.

The pump does not detect Check that:

rising pressure between marks. e The administration set is not damaged

An error message appears.

® Air was inserted

® The Extension Set is connected correctly

If one of the conditions is not met, correct it, and

then press Restart. Perform reset of the test.
If the set is undamaged, and the test was

performed properly, press Confirm. The program

proceeds to the Air Detector test.
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Air Detector Test

The following issue can arise during the Air Detector test:

Problem Management

Air could not be detected If air was not inserted into the administration set,
within 30 seconds of pressing ~ press Restart. Then, repeat the test, starting at
Start. An error message the Test screen. If air was inserted into the
appears. administration set, press Confirm. The program
proceeds to the Flow Accuracy test.
Error message appears Close the test software, reopen and ensure to
indicating “Cannot Start carry out the "Setup" sequence, as described in
Pump” Logging In on page 87.
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Flow Accuracy Test

The following issues can arise during the Flow Accuracy test:

Problem Management

Test is completed too quickly.  Verify that:
An error message appears. ® The Flow Accuracy Container is in an upright
position

® The hydrophobic filter is dry
® The container is full
If the conditions are not met, press Restart.
Empty the Flow Accuracy Container and replace
the filter. Position the Container upright, using
the hanger. Then, press Start. The test begins
again. If the conditions are met, press Confirm.
The program proceeds to the Finish screen.

Test is not completed within Verify that:
the expected amount of time. e The administration set is connected to the Flow
An error message appears. Accuracy Container

® All connections are tight

® There are no leaks in the Container or the cap
If the conditions are not met, correct them, and
then press Restart. Empty the Flow Accuracy
Container and replace the filter. Position the
Container upright, using the hanger. Then, press
Start. The test begins again. If the conditions are
met, press Confirm. The program proceeds to
the Finish screen.

Pump has stopped even Repeat the Flow Accuracy test
though no pressure was built.

The test aborted and the

pump switched to prime state.
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ACT General

o For issues common to both ACT and FasTest PM, see also
General on page 95

The following are general issues that can arise during certification testing:

Problem

The ACT software stops during
the test

The ACT test failed

The certificate printing process
failed; information is printed
without the certificate image
background.

During the ACT installation the
following is prompted: "This
application requires .NET
Framework 4.0 full, please
install the .NET Framework
and then run the installer
again."

151

Management

Re-start the ACT software and begin the test from
the start.

Repeat the ACT test only if you suspect that an
incorrect technique may have been used, or there
was faulty test equipment (e.g. loose cap on
bottle, not enough back pressure introduced etc.)

Perform one of the following options:

1.Go to the service portal https://
service.qcore.com/; and search for the Device;
then, from the Maintenance tab, download the
certificate.2.Provide the pump S/N and
certification date to service@qcore.com and the
certificate will be emailed to you.

3.Use the "print screen" option and copy the
certificate image to a suitable application to
print.

® Click OK to cancel the installation.

® On the computer: Go to Start —All
Programs -»Windows Update.

® Select Optional Updates and then select .NET
Framework 4.0.

¢ Follow the online instructions to complete the
update.

® Double-click the ACT Setup file to start the
installation again.
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Problem

During the ACT installation the
following is prompted: "This
application is supported on
Windows XP, Windows 7 and
higher."

Management

® Use a computer with the appropriate operating
system.
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Chapter 5: Replacing the Battery

The following sections describe how to replace the battery in the Sapphire

pump:
(O a1 Y= -1 (=T [ 154
Replacing the Battery .......coceviiiiiiiiiiiiiii e 155

Getting Started

The Sapphire pump uses Li-lon batteries, which are supplied by Q Core
Medical Ltd. Only qualified technicians should replace the batteries.

A Before and during battery replacement, always adhere to the following

safety precautions and guidelines:

®  Make sure that the pump is turned off, and disconnected from an external
power supply.

®  Replace the battery only with the same type. An explosion hazard exists if
the battery is replaced by an incorrect type or not according to the
instructions.

® Do not short circuit the battery terminals. Do not disassemble or modify
battery packs.

* Do not dispose of batteries or battery packs in fire.

® The packaging, the administration sets, the battery, and any other
electronic components must not be disposed of as unsorted municipal
waste, and must be collected separately in accordance with applicable
environmental laws (such as the WEEE Directive for Waste Electrical and
Electronic Equipment). Contact an authorized representative for
information concerning the decommissioning of your equipment.
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Required Equipment

Before beginning the battery replacement procedure, verify that the following
equipment is available:

® Li-lon battery (supplied by Q Core)

®  Number 3 flat screwdriver, or number 1 Phillips screwdriver

Replacing the Battery

The following procedure explains how to change the battery. Before
beginning, it is recommended to disconnect the administration set from the
pump, and clean/sterilize the pump. After replacing the battery it is required
to set the date and the time.

o It is possible to set the date and time in the Pump
Configuration menu. See Defining Regional Parameters on
page 170 (Sapphire and SapphireH100) or Defining Regional
Parameters on page 230 (SapphirePlus).

> To replace the battery:

1. Verify that the pump is turned off, and disconnected from an external
power supply.
2. Using a number 3 flat screwdriver or number 1 Phillips screwdriver,

unscrew the battery door screw, until the door is loose enough to
remove.

3. Separate the battery door from the pump by inserting the screwdriver
under the protruding strip near the door hinge. The battery door screw
remains attached to the door.
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Figure 5.1. Battery Door

Protruding
Strip

Battery
Door Screw

4. Carefully remove the battery from the battery compartment, and
disconnect it from the battery connector.

L Never pull/push the wires to disconnect/connect the battery
connector. Hold the connectors parts directly and pull/push
them by hand.
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5. Set the old battery aside, record the new battery's serial number prior to
installing it in the device. Report the battery's serial number in the Service

Portal.

i

When the battery is connected, the pump automatically
turns on.

Reporting on battery replacement in the Service

Portal:

® Go to the Service portal in the following address https://
service.qcore.com/Main.aspx.

® | ogin using your credentials.

® In the Service Portal Home Page click Battery Replace-
ment.

® Fill in the details of the device and the replaced battery.
Proceed to the Battery Replacement Report and
Checkout.

For more information on the Service Portal refer to the
Service Portal Work Instructions, 16019-049-0001-SRV.

6. Inspect the battery cable and chamber, and verify that:

® The battery cable is in good condition
® Wires are not exposed or disconnected

® The battery chamber is free of loose particles and dirt

/. Position the battery on top of the connector inside the battery chamber
so the battery door can be easily installed. Make sure the connector and
wires are positioned to the side of the battery, and not on top of it

157
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Figure 5.2. Battery Connector.

Connector

8. Installing the door:

Starting at the side closer to the top of the pump, position the door by
engaging it with the two hinges. Then, from the opposite side, carefully
close the door until it snaps into place.
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Figure 5.3. Installing the Battery Door

New battery cover

The new battery cover includes a white over-mold seal instead of the
previous black one.

For pumps with the black O-ring seal on the battery cover, verify that the
O-ring cannot be seen after closing the battery cover.

For pumps with the white over-mold seal on the battery cover, verify that
the over-mold is not pinched, and that it cannot be seen after closing the
battery cover.

159 Sapphire Infusion Pump User Manual



Figure 5.4. Battery Covers Comparison

Current Battery Cover

9. Tighten the battery door screw.

/ Avoid using extensive torques, as they may crack the plastic
a housing or harm the screw thread.
9

10. Inspect the battery door, and verify that:

® The door is not raised
® The door is aligned with the bottom shell of the pump
® The O-Ring cannot be seen
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Chapter 6: Sapphire & SapphireH100

Configuring Basic Pump Settings

The following sections describe how to view and update basic pump
configuration settings, using the Options menu:

Managing Alarm SELHINGS ....civveiiiiie e e et e e e e e e e eaes 162
Configuring General SETtINGS ...ccvvviiiiiieiiee e 164
Defining Regional Parameters .........ccooovueiiiiiieiiie e 170
o For a description of all basic pump options, refer to the

Sapphire User Manual.

Managing Alarm Settings
The Alarms menu enables you to view and modify alarm-related options.

> To access the Alarms menu:

®  From the toolbar of the Start Up screen, select Options. Then, select
Pump configuration > Alarms.

To Modify
Parameter (from

the Alarms
Descriptions screen)

Occlusion units ~ The format of occlusion units (BAR, PSI or Select Occlusion
mmHg). units. Then,
select BAR, PSl or
mmHg.
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Descriptions

To Modify
Parameter (from
the Alarms
screen)

Occlusion
Alarm

Pump
unattended

Infusion near
end

The minimum downstream pressure that
triggers an Occlusion alarm. Acceptable
ranges are 1.5t017.4 PSI, 0.1 to 1.2 BAR or
75 to 900 mmHg. An alarm sounds when
the downstream pressure reaches the set
value = the sensor sensitivity level.

During infusion, the current downstream
pressure is displayed on the Pressure
display screen (for more information refer
to the SapphireH100 User Manual) and on
the screen saver.

The number of consecutive minutes of no
interaction with the pump after which a
Pump Unattended alarm is triggered.
Options are 2, 5, or 10 minutes.

Note: A Pump Unattended alarm is not
triggered while an infusion is running.

The number of minutes before completion
of an infusion at which an Infusion Near
End alarm is generated.

Options are 1, 3, 5, or 10 minutes, disable
the alarm by selecting Off.

Select Occlusion
Alarm. Then,
using the keypad,
enter the desired
valueand press
OK.

Select Pump
unattended.
Then, select 2
min, 5 min, or 10
min.

Select Infusion
near end. Then,
select 1 min, 3
min, 5 min, 10
min, or Off.

Local configuration changes made after the Drug Library is
loaded, will be valid until the pump is turned off.

When resuming an infusion after pump shutdown, local
configurations will remain until the end of the current
infusion. For more details regarding Drug Library, refer to

the Sapphire User Manual.
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Configuring General Settings

The General settings menu enables you to view basic pump settings, and
modify them according to clinical requirements.
> To access the General settings menu:

®  From the toolbar of the Start Up screen, select Options. Then, select
Pump configuration - General settings.

* To save changes press Next and then OK.

To Modify Parameter

(from the General

Descriptions/Notes settings screen)
Current CCA Used to select the CCA to whichthe  Select Current CCA.

pump should be set. Appears only Choose the

when a Drug Library is loaded. appropriate CCA,; then,

from the Attention
screen press OK.

Start Up Config.  Set the configuration of the Start See the User Manual
Up screen. Includes Repeat Last
Infusion and PreProgram options.
When the Repeat Last Infusion
option is enabled, the Repeat Last
Infusion frame appears on the Start

Up screen.
Authorization Sets the authorization lock level of Select Authorization
level the pump. level. Then, enter a
password and select
Low,
Medium, High or
Tech.
Allow delayed Enables/disables programming of Select the Allow
start infusions that begin after a delayed start row, to
predefined period of time (or after toggle the option
standby). When the option is between On and OFf.

enabled, the Set Delay frame
appears on the Start screen.
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To Modify Parameter

(from the General

Set Prime
Volume

Backlight

Prime Reminder

Advanced Bolus

165

Descriptions/Notes

The amount of fluid used to prime
the administration set when
automatic priming is performed.

The acceptable range is 2 to 25 mL.

If a value outside the permitted
range is entered during
programming, the OK function key
is disabled.

Sets the degree of screen dimming
while the pump is running. The Off
and Partial options of this feature
save power and promote longer
battery life.

Enables a reminder for the user to
prime the administration set before
starting an infusion.

Allows users to program a bolus by
entering rate, amount and time.
When this option is disabled, the
bolus is programmed by amount
only, and the rate is the default
bolus rate. The option is available
only when Allow Bolus is enabled
(under Technician options).
Applicable only for the Continuous
delivery mode.

settings screen)

Select Set prime
volume. Then, using
the keypad, enter the
desired value and press

OK.

Select Backlight.
Then, select On, Off
or Partial.

Select the Prime
Reminder row, to
toggle the option
between On and Off.

Select the Advanced
Bolus row, to toggle
the option between

On and Off.
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To Modify Parameter

(from the General

Descriptions/Notes settings screen)
Bolus Reminder Enables a reminder for the user to Select the Bolus
connect the bolus handle before Reminder row, to
starting a PCA, PCEA or PIEB toggle the option
infusion that includes patient between On
boluses. The reminder:
and Off.

® Instructs to connect the bolus
handle directly to the pump.

® Checks functionality - bolus press
is recognized by the pump.

Auto. P. Lockout  Enables/disables Patient Select the Auto P.
Lockout, a safety feature that Lockout row, to
requires password entry to make toggle the option

any parameter changes. When the between On and Off.
option is enabled, Patient

Lockout is activated automatically

when an infusion begins.
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To Modify Parameter

(from the General

Screen Saver

Keys Volume

167

Descriptions/Notes settings screen)

Enables/disables a far-view display Select the Screen
of the main infusion parameters Saver row, to toggle
during a running infusion. These the option between
include drug information, delivery On and Off.

mode (color indication), infusion

rate and the current phase (dose,

continuous rate, etc.). In

SapphireH100, software 13.22.3,

the pressure bar will also be

displayed.

The screen saver appears 30

seconds after the infusion program

has started, and the pump has not

been touched.

The screen saver will not appear in

the following cases: Delayed start,

end of infusion KVO, or during a

Bolus delivery.

The screen saver will disappear in

the following cases:

® Alarm - screen will revert to the
alarm screen

® Touching the screen - screen will
revert to the Running screen

® Infusion is paused - screen will
revert to the Paused screen.

Sets the speaker volume for the Select Keys Alarm
auditory signal generated when Volume. Then, select
users select functions and presskeys  Low, High, or Off.
on the pump.

Note: When keys volume is set to

Off the bolus handle is silenced.
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To Modify Parameter

(from the General

Alarm Volume

Authorization
level

Allow delayed
start

Allow
PreProgram

Descriptions/Notes

Sets the speaker volume for the
auditory alarm signal. Options are
Maximum or Minimum.

When the option is set to Minimum,
Messages are provided with a visual
signal only. Level 1, 2, or 3 alarms
are provided with visual and the
lowest auditory signal permitted,
according to IEC 60601-1-8.
Infusion Complete message is
provided with a visual and auditory
alarm signal, which will not be
affected by the volume changes.
For more information about
messages and alarms, refer to
Alarms and Troubleshooting on

page 189.

Sets the authorization lock level of
the pump.

Enables/disables programming of
infusions that begin after a
predefined period of time. When
the option is enabled, the Set Delay
frame appears on the Start screen.
Note: This feature functions like a
timer.

Enables/disables starting infusions
using predefined infusion
parameters. When the option is
enabled, the PreSet Programs frame
appears on the Start screen.

Sapphire & SapphireH100

settings screen)

Select Alarm Volume.
Then, select Maximum
or Minimum.

Select Authorization
level. Then, enter a
password and select
Low, Medium, High, or
Tech.

Select the Allow
delayed start row, to
toggle the option
between On and Off.

Select the Allow
PreProgram row, to
toggle the option
between On and Off.
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To Modify Parameter

(from the General

Descriptions/Notes settings screen)
Set Prime The amount of fluid used to prime Select Set Prime
Volume the administration set when Volume. Then, using
automatic priming is performed. the keypad, enter the

The acceptable range is 2to 25 mL.  desired value = OK.
If a value outside the permitted

range is entered during

programming, the range is

displayed in red font, and the OK

function key is disabled.

Backlight Sets the degree of screen dimming  Select Backlight. Then,
while the pump is running. The Off select On, Off, or
and Partial options of this feature Partial.
save power and promote longer
battery life.
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Defining Regional Parameters
The Regional menu controls date, time, and language settings.

> To access the Regional menu:

1. From the toolbar of the Start Up screen, select Options. Then, select
Pump configuration - Regional.

2. Select the US format row to toggle the option between On and Off.

The following procedures explain how to configure settings from the Regional
menu.

> To set the date:
1. Select the Date row.

2. Using the keyboard, enter values (2 digits each) for the day, month, and
year. (When U.S. format is set, the order is month, day, and year.)

3. To confirm the new settings, press OK.

> To set the time:
1. Select the Time row.

2. Using the keyboard, enter values (2 digits each) for the hour and the
minute.

3. If necessary, switch the time units from AM to PM, or vice versa, by
pressing the AM/PM function key. (This step is relevant only when U.S.
format is set to On.)

4. To confirm the new settings, press OK.
> To set the language:
1. Select the Language row.

2. Select the required language.

o In some pumps, only the default language is listed.

3. To confirm the new settings, press OK.
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SapphireH100 Design

The new SapphireH100 safety door is designed to accommodate the
dedicated SapphireH100 line of sets. If needed, regular Sapphire
administration sets can be used with the SapphireH100 infusion pump as well.

Figure 6.1. SapphireH100 infusion pump

Figure 6.2. SapphireH100 infusion pump cassette
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SapphireH100 Infusion Pump Functions

Delivery Modes

SapphireH100 infusion pump supports the following delivery modes:

Continuous
Multi-step
Intermittent
TPN

Pressure Settings

The SapphireH100 infusion pump pressure values are 0.2 — 1.2 Bar (2.9- 17.4
PSI, 150-900 mmHg), at increments of 0.1 bar (the increment in PSl is 0.1 PSI.
The increment in mmHg is 1 mmHg).

Using Technician Options

The following sections describe the configuration options available to users
with a Technician authorization code:

OVEBIVIBW <.ttt ettt et et e et et e e et e et e e e e eaeean e 173
AlQrMS MANAEET weniiiniiieeie et e et eeee et e e e et e e ae e st e et e et eesnaasrneeens 174
Managing PUmpP SetEiNGS ...cueiiniiiiri e ee 174
Viewing General Info Parameters .........cccoovueeeiiiieeiiiieeeeiee e 187
Calibrating the SCrEEN ...ueeieiie e e 188
Testing the Hard KBYS ....ccvueiiiiieieiie et e e e e e eaa e 188
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Overview

The Tech. options screen provides access for viewing and managing settings
used for calibration, testing and maintenance purposes.

> To access the Tech. options screen:

1. From the toolbar of the Start Up screen, press Options.
The Options screen appears.

2. Select Technician options.

The Tech. options screen appears.

o The Tech. options screen is accessible only when the pump
is set to Technician authorization level. If the Technician
options selection does not appear on the Options screen,
change the authorization level to Technician and repeat the
procedure. (For details refer to Setting Technician Lock
Level on page 38.)
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Alarms manager

This function is reserved for Q Core Medical’s internal use only.

Managing Pump Settings

The pump settings screen provides access to pump configuration settings that
can be managed only by a technician. The screen is accessed from the Tech.
options screen by selecting Pump settings.

The following sections describe:

Setting Hard LIMItS .......eiiiiiieiiiiiie e e e e e e e v e 174
SEttiNg KVO Rt couiniiiiiiiiie i e e e e e e e eens 176
Setting Air Detector Settings and Thresholds ..........cccooevviiiiiiiiieiiiiineiiene, 177
Resetting the SYSTEM .....cuuiiiii e 180
Configuring General SEttiNgS ....ccuuiiiiiiii i 182

Setting Hard Limits

The hard limit is the acceptable range of a given parameter; the hard limit is
displayed in the upper right corner of the main display while entering the
parameter.

The Set hard limits screen provides access for viewing and modifying the
upper limits of infusion parameter ranges. Parameter’s hard limits and
permitted ranges are mode-specific. Parameters of a given mode can be
viewed and updated only when the pump is set to that delivery mode.
Settings are not saved after turning off current delivery mode.

Hard Limit Parameters for Continuous and Multi-step Delivery Modes

Delivery Mode VTBI Rate Time
Continuous v v
Multi-step v v v
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Hard Limit Parameters for Continuous, when Set Secondary is set to On (for
more information refer to To enable secondary settings: on page 186)

Delivery Primary Primary Secondary Secondary

Mode VTBI Rate VTBI Rate
Continuous v v v v

Hard Limit Parameters for TPN, and Intermittent Delivery Modes

Delivery Max Dose

Mode VTBI Time Int. Dose
TPN v

Intermittent v/ v v

Hard Limit Parameters for PCA, PCEA and Epidural Intermittent Delivery
Modes (Sapphire only)

Min. Max.
Delivery Int. Cont. Dema*nd Loading Bolus Bolus Bolus
Mode  VTBI Dose Rate Bolus Dose Rate Lockout Lockout
PCA v v v v v v v
PCEA v v v v v v
Epi. Int v v W v N e

" Changing the hard limits of the Demand Bolus parameter also applies to the
Clinician Bolus parameter.

™ The hard limits of this option can be only changed when PIEB is set to On (in
the Epi. Int. menu).

175 Sapphire Infusion Pump Service Manual



> To update hard limits for a delivery mode:

1.

From the Tech. options screen of the relevant delivery mode, select
Pump settings — Set hard limits.

The hard limit parameters for the current delivery mode are displayed.
Select the row of the parameter that you want to change. Using the
keypad, enter the required value, and then press OK.

To exit the Set hard limits screen, from the toolbar, press either OK or
Exit. The Start Up screen is displayed.

Setting KVO Rate

KVO is the rate of fluid that is delivered to the patient when the infusion
program is completed, in order to prevent clotting in the infusion cannula.
Separate KVO rates can be set for different delivery modes. The permitted
range for the KVO rate parameter is 0-20 mL/h (for all delivery modes).

o It is not necessary to change the delivery mode of the pump
to program KVO rates for the different modes. The KVO
screen of each delivery mode provides access to setting
KVO rates for all other delivery modes, with the exception of
intermittent and Epidural intermittent.
For intermittent and epidural intermittent KVO rate is
programmed for every infusion.

> To set the default KVO rate for a delivery mode:

1.

From the Tech. options screen, select Pump settings = Set KVO. The
KVO screen appears, with a list of delivery modes displayed.

Select the delivery mode whose parameter is to be updated.
The keypad is displayed.

Using the keypad, enter the value of the required KVO rate. Then, from
the toolbar, press OK.

The KVO rate for the selected delivery mode is set.
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4. To set the KVO rate for an additional delivery mode, repeat Steps 2-3.

5. To exit the KVO screen, from the toolbar, press Exit. The Start Up screen
is displayed.

Setting Air Detector Settings and Thresholds

The Air detector screen provides access for viewing and modifying the
amount of air in the administration set that triggers an "Air in Line’ alarm. Air
detector configuration is a general pump setting that needs to be set only
once. Values configured for air detection in one delivery mode are
automatically applied to all other delivery modes.

o In Epidural modes, both Single and Accumulated can be
switched to Off.
When changing the delivery mode to NON epidural - one of
the setting will turn on.

The Sapphire pump has 2 mechanisms for triggering the Air In Line alarm:

® Single air detector: In this mechanism, every time that a single bubble
equal to or larger than a user-selected size passes through the detector,
an alarm is triggered.

e  Accumulated air detector: In this mechanism, the user selects values for
both accumulated bubble size and the accumulated amount (threshold).
Any single bubble equal to or larger than the selected accumulated
bubble size is included in the counter of accumulated air. When the total
amount of accumulated air reaches the selected accumulated threshold
value within a 15-minute period, an alarm is triggered.
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In most software versions it is possible to turn off either the Single Air
Detection or the Accumulated Air Detection but not both — Epidural Mode
(Sapphire only) is the exception to this.

> To set air detector settings:

1. From the Tech. options screen, select Pump settings = Set air detector.
The Air detector screen appears.

2. Set the single air detector value:

a. Select the Single Air Detector row.
The Single bubble screen appears, with a list of values displayed.
b. Select the required value. To deactivate this mechanism, select Off.
The Air detector screen reappears.

3. Set the accumulated air values:

a. Select the Accumulated Air Detector row.
The Accum Bubble screen appears, with a list of values displayed.
b. Select the required value. The Air detector screen reappears.
c. Select the Accumulated Threshold row.
The Accum Threshold screen appears, with a list of values displayed.
d. Select the required value. To deactivate this mechanism, select Off.
The Air detector screen reappears.
e. To save changes in the system, from the toolbar, press OK.
The Start Up screen appears.

o If the pump is not in Epidural delivery mode and both air
detector mechanisms have been set to Off, an error
message appears on the Attention screen, and you are
prompted to reconfigure the values (Sapphire only).

Only in software versions that support disabling of the Air Detection

A technician authorization code is required to enable or disable the Air
Detection setting (this can only be set manually on the pump and not with the
Drug Library Editor).

Sapphire & SapphireH100 178



To set the Air Detection setting select: Options— Technician options—> Pump
settings— Set air detector— Air Detection.

Toggle the setting to Off to disable the pump air detection during infusion. If
the Air Detection setting is disabled, the icon E will appear at the right side

of the indicators bar. Toggle the setting to On to enable air detection during
infusion.

No Air in Line alarm is triggered when the pump air detection is disabled. This
feature should be used when meeting the clinical practice and guidelines and
coupled with an alternative method of eliminating air. When the Air Detection
is disabled, use a set with an air-eliminating filter to prevent injury. Always
ensure the administration set is primed before starting an infusion.

The Air Detection setting is available on all delivery modes, except Epidural.
Disabling air detection in Epidural mode can be done manually, or via the
Drug Library Editor, by switching both Single and Accumulated Air Detector
settings to Off. This functionality remains the same as in previously available
Sapphire Multi Therapy Infusion Pumps software versions.

Air In Line Alarm

The Single air detector will automatically switch to On in the following
conditions:

® The Single air detector was set to OFF

*  The SapphireH100 infusion pump is operating on rate lower or equal to
4ml/h.

o Valid for rate, continuous rate, KVO rate and bolus rate.

® Ifthe pump is operating on rates between 0.1mL/h to 0.9mL/h, the Single
air detector automatically switch to On. If 0.1 mL air bubble was
identified, the Air in line alarm will be activated.

® Ifthe pump is operating on rates TmL/h to 4mL/h , the Single air detector
will automatically switch to On. If 0.5 mL air bubble was identified, the Air
in line alarm will be activated.
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If the pump is operating on a rate higher than 4mL/h, the Single air detector
will automatically switch back to OFF.

Resetting the System

The Reset System option is used to

® Reset all pump parameters and features to the factory defaults settings.
®  Define new security passwords.

® Remove the Drug Library.

® Remove the PrePrograms.

Factory defaults

> To set pump parameters to factory default settings:

1. From the Tech. options screen, select Pump settings > Reset system.
The Reset system screen appears.

2. Select Factory defaults.
The Attention screen appears.
3. To confirm the reset, from the toolbar, press OK.

Changes are saved in the system, and the Start Up screen appears.

Passwords

To help ensure patient safety, the Sapphire pump can be set to one of four
authorization levels. For more information regarding the different
authorization levels, refer to Configuring General Settings on page 164.

> To change the passwords:

1. From the Tech. options screen, select Pump settings - Reset system.
The Reset system screen appears.

2. Select Passwords.

3. Select authorization level password,or PreProgram password, to change.
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4. In PreProgram enter a 4-digit password in the specified range
[1000 - 9999]. In an authorization level, enter a 4-digit password in the
specified range [1000 - 7000].

o Passwords for each security level must be unique and in the
specified range. The OK button will be disabled when
entering the same password for more than one security
level.

The PreProgram password can be identical to an authorization level
password, yet there is no connection between the options the
authorization level enables and the PreProgram option.

5. Press OK to save the changes.

Remove Drug Library

The Drug Library can only be removed by users with Technician authorization
level. This option will be hidden if there is no Drug Library on the pump. When
the user removes the Drug Library all pump parameters are set to factory
defaults.

1. From the Tech. options screen, select Pump settings - Reset system.
The Reset system screen appears.

Select Remove Drug Library.

Press OK to confirm. The Start Up screen will appear.

o SapphirePlus, software revision 14, the WiFi resets after the
users confirms Drug Library removal.

Remove PreProgram

Enables the removal of all preset programs configured on the pump (in all
delivery modes).

1. From the Tech. options screen, select Pump settings > Reset system.
The Reset system screen appears.

2. Select Remove PrePrograms.
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3. Press OK to confirm. The Start Up screen will appear.

Configuring General Settings

The General screen provides access for viewing and modifying selected basic
pump settings. Some of these settings are common to all delivery modes.
Others are specific to certain delivery modes, and appear only when the
pump is set to those modes.

> To access the General screen:

®  From the Tech. options screen, select Pump settings > General.

The General screen appears.
The following settings appear in all delivery modes. Changes made while the
pump is in one delivery mode are automatically applied to all other delivery
modes.

Setting Description/Notes Default Value

Delivery Mode Determines the available delivery modes. On
Each mode can be turned off separately.

New patient Allows users to associate an infusion witha  Off
patient and reset the Accumulated VI
(accumulated volume infused).

Occ. Auto-restart Enables the pump to automatically restart ~ On
an infusion,
up to 5 times an hour, if a downstream
occlusion was detected and cleared within

40 seconds.
Calculate Determines if the user enters final Off
Concentration concentration or Drug Amount and

Diluent Volume.
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Setting Description/Notes Default Value

mL/h only Enables the user to use units other than Off
mL/h.
If this option is disabled, programming will
automatically default to mL/h. This feature is
available in the absence of a Drug Library
on the pump.

Med. Titration Allows users with medium authorization Off
level to change rate during a running
infusion.

The following settings appear in the Audio Settings menu:

Setting Description/Notes Default Value

Keys Volume Sets the speaker volume for the High
auditory signal generated when the
user selects functions and presses keys
on the pump.
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Setting Description/Notes Default Value

Alarm Volume Sets the speaker volume for the Maximum
auditory alarm signal. Options are
Maximum or Minimum.

When the option is set to Minimum, s
are provided with a visual signal only.
Alarm levels 1, 2 and 3, and the
"Infusion Complete" are provided with
a visual signal and the lowest auditory
signal permitted according to IEC
60601-1-8.

Maximum alarm volume is 70 dB.
Minimum alarm volume is 56 dB.

Note: Auditory alarm signal sound
levels which are less than ambient
levels can impede operator recognition
of alarm conditions.

Bolus Handle Sets the Bolus auditory signal On
generated when the bolus handle is
pressed.
When the option is set to Always On,
an auditory signal is generated each
time the bolus handle is pressed. When
set to When Bolusing, an auditory
signal is generated upon pressing of
the bolus handle only when bolus is
available.
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The following settings appear only when the pump is in the Continuous
delivery mode:

Setting Description/Notes Default Value
Set Secondary Allows users to program a Secondary Off
(Piggyback) infusion.

Allow Bolus Allows users to program a bolus during ~ Off

a Continuous infusion. When this
feature is enabled, the Bolus button
appears in the toolbar during the
running infusion.

Bolus Rate Specifies the rate of delivery of a fast 125 mL/h
dose, for rapid volume infusion.

Sec. Bolus Rate Specifies the rate of delivery of a fast 125 ml/h
dose for a Secondary (Piggyback)
infusion.

To save changes press Next and then OK.
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> To set the general settings:

1.

From the General screen, select the row of the relevant option, to toggle
the setting between On and Off.

2. After changing the setting(s), from the toolbar, press OK.

Changes are saved in the system, and the Start Up screen appears.

> To set the bolus rate:

1.

From the General screen, select the Bolus Rate row.
The Bolus rate screen appears.

Using the keypad, enter the required rate. Then, from the toolbar, press
OK.

The General screen reappears.
After changing the setting(s), from the toolbar, press OK.

Changes are saved in the system, and the Start Up screen appears.

> To enable secondary settings:

1.

From the General screen, select the Set Secondary row, to toggle the
setting between On and Off.

From the toolbar of the General screen, press OK.

Changes are saved in the system, and the Start Up screen appears.
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The following settings appear only when the pump is in the PCA, PCEA and
Epi. int Options menu (relevant for Sapphire only):

Setting Description/Notes Default Value

Limit Period 1 h(s)

Specifies the time period to
which the dose limit type is
applied (during the selected
time, the delivered boluses will
be limited by either maximum
number, or by maximum
volume). Options are 1 hour or 4
hours.

> To set the Limit Period:

1. From the General screen, select the Max bolus per row.
The Max Bolus screen appears, with the possible options displayed.

2. Select the required option.
The General screen reappears.
3. From the toolbar of the General screen, press OK.

Changes are saved in the system, and the Start Up screen appears.

Viewing General Info Parameters

This option is reserved for Q Core Medical’s internal use only.
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Calibrating the Screen

The Screen Calibration option enables you to calibrate the screen, to ensure
that the values and options displayed on the screen match those that were
entered or selected by the user.

> To calibrate the screen:

1.
2.

From the Tech. options screen, select Screen calibration.

Press the center of the Red "plus" sign. You may be prompted to repeat
this several times.

When prompted, press the center of the Green Box icon to complete the
calibration.

When calibration is successfully completed, the Tech. options screen
reappears.

Testing the Hard Keys

The Key test screen enables you to test the function of the Stop hard key and
the On/Off hard key. The test can be performed in any delivery mode.

> To test the hard keys:

1.

From the Tech. options screen, select Key test.
The Key test screen appears.

Press the Stop hard key, and verify that the setting in the Stop button row
changes from Released to Pressed.

Release the Stop hard key, and verify that the setting in the Stop button
row changes from Pressed to Released.

Test the On/Off hard key, using the method described in Steps 2 and 3
above.
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Alarms and Troubleshooting

The following sections describe the different types of alarms and messages
that can be generated by the Sapphire pump from the perspective of the
pump user. The material set out here offers the trained technician tips and
specific corrective actions. The trained technician will find this material helpful
in troubleshooting common programming issues.

Topics covered include:
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Guidance in Problem SoIVING .....couiiiiii i 196

Alarms Overview

The Sapphire pump generates four different types of alarms. The alarm types
are categorized according to their effect on the infusion. In all alarm types,
instructions about how to proceed (and, if relevant, to solve the problem) are
displayed on the touch screen.

Alarm Type Effect on Infusion

Level 1 Pump shuts down.

Level 2 Infusion stops and cannot be reactivated.
Level 3 Infusion stops, but may be reactivated.
Message Infusion is not interrupted.

When Level 1, 2, and 3 alarms occur, the red alarm LED is on or blinking
continuously, and an auditory alarm sounds continuously. These alarms
require immediate attention.

189 Sapphire Infusion Pump Service Manual



The following sections provide details about each alarm type.

o Tip for 1st level support: Start faulty pump examination by
connecting the pump to power.

Level 1 Alarms

This type of alarm is the highest severity alarm category. If the pump is
running when the alarm occurs, the infusion stops immediately, and the pump
automatically shuts down within 3 minutes. The infusion cannot be restarted
or continued.

The following soft keys are available during a Level 1 alarm:
®  Mute: Silences the auditory alarm.
®  Shutdown: Turns off the pump immediately.

When a Battery Depleted alarm occurs, connect the pump to an AC power
supply. A pump with an Internal Error alarm isrecommended to be evaluated
by a trained service technician.

Alarm Title Displayed Text

Battery Depleted Pump will automatically shut down in 3 minutes.
Please connect pump to power.

Internal Error Pump will automatically shut down in 3 minutes.
Please send the pump for service.
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Level 2 Alarms
This alarm type is a high severity category. If the pump is running when a
Level 2 alarm occurs, the infusion automatically stops.

The pump can be reactivated by a technician (using a technician authorization
code) to retrieve infusion data and/or manage a battery problem. Pumps with
Level 2 alarms need to be sent for servicing. Screen instructions are directed
to trained technicians only.

The following soft keys are available during a Level 2 alarm:
e  Mute: Silences the auditory alarm for 2 minutes.
® OK: Displays the Paused screen.

Alarm Title Displayed Text

Mechanism Error A pump fault has occurred, please enter technician code to
proceed.*

Pump Fault A pump fault has occurred, please enter technician code to
proceed.*

* Entering the code will give trained technician same or more information about the
problem and possible solutions. In most instances, trained technician will be
directed to return pump for service.
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Level 3 Alarms

This alarm type is a medium severity category that requires immediate
attention.

If the alarm occurs during an infusion, the infusion automatically stops.
However, the caregiver may continue the infusion after the problem has been
resolved. Instructions for resolution of the problem are displayed on the touch
screen.

Figure 6.3. Sample Level 3 Alarm Screen
Alarm | Continuous[ssas]
Air in Line

Please prime administration
set.
If problem reoccurs, remove
and reinsert the cassette

Prime hiute

The following soft keys are available during a Level 3 alarm:

®  Mute: Silences the auditory alarm for 2 minutes.

®  Unmute: Returns the auditory alarm. This soft key is enabled after Mute
is pressed.

®  OK: Displays the Paused screen. The infusion may then be resumed after
the problem is resolved.

®  Prime: Enables automatic priming. This key appears only during an Air in
Line alarm.
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Alarm Title

Displayed Text

Air in Line

Cassette
Misplaced

Check for
Occlusion

Downstream
Occlusion

Flow Error

Occlusion

Pump Stopped

Potential Air in
Line

Upstream
Occlusion

Insufficient Battery

193

Accumulated air in line is over the limit. Please prime
administration set.

Prime administration set. If problem reoccurs, remove and
reinsert the cassette.

Possible excessive environmental light. Please reduce
exposure and check if priming is required.

The administration cassette is not loaded or misplaced.
Please reload the cassette.

Reinsert cassette. Verify that both flanges are inside the safety
door. If problem persists contact technician.

Remove the administration cassette and verify that the
cassette chamber clean; then, correctly reinsert it. If alarm
reoccurs please contact trained technician.

Please verify clamps are open and set is not occluded.

To clear occlusions verify: 1. Clamps are open; 2.
Administration cassette is properly positioned; 3. Line is not
kinked; 4. No occlusion at the output connection. If all
occlusions were cleared press OK to continue.

Verify that the administration cassette is correctly positioned
and battery is sufficiently charged. If alarm reoccurs contact
trained technician.

To clear occlusions verify: 1. Clamps are open; 2.
Administration cassette is properly positioned; 3. Line is not
kinked; 4. No occlusion at the output connection. If all
occlusions were cleared press OK to continue.

Please quit and then restart the infusion.

Press OK to test for air.

To clear occlusions verify: 1. Clamps are open; 2.
Administration cassette is properly positioned; 3. Line is not
kinked; 4. No occlusion at the output connection. If all
occlusions were cleared press OK to continue.

Low battery voltage for current rate. Please connect pump to
power supply.
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Messages

A Message indicates a condition of medium severity that you should attend to
as soon as possible. When a Message occurs, an auditory alarm sounds, and

the condition that triggered the message (with recommended actions, if
relevant) is displayed on the touch screen.

Figure 6.4. Sample Message Screen

Message {continuouss ]

Message

The pump has been
inactive for 10 minutes

If a message is displayed during infusion, the infusion continues, and the
system continues to operate. The following soft keys are available:

®  Mute: Silences the auditory alarm for 2 minutes.

®  OK: Confirms the message, and returns the display to the previous
screen. If the infusion is complete, the pump returns to the Start Up
screen.

Sapphire & SapphireH100
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Screen Header  Displayed Text

Low Battery 30 minutes left to battery depletion. Connect pump to
power supply.

Battery Reminder  End of battery life, please contact trained technician to
replace battery.

Message Battery life will expire in 2 days. Please contact trained
technician.

The battery could not be fully charged - please check
power supply.

Door open. Check administration cassette position and
close the safety door.

Infusion complete.
Infusion near end.
The pump has been inactive for <xx> minutes.

System temperature is out of range. If alarm reoccurs
please contact trained technician.

Please Wait. Possible Downstream Occlusion. The pump
is attempting to restart; press exit to cancel.

Key stuck. Please release the key
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Guidance in Problem Solving

The Guidance in Problem Solving section provides practical tools for 1st level
analysis of problems and resolution.

For troubleshooting in Sapphire and SapphireH100 refer to the
Troubleshooting Software Upgrade section on page 211.

Alarms Description List

The alarm title is displayed in the Event Log. Reviewing the Event Log is an
essential tool in the analysis of a problem.

Alarm Title Description Solution
Watchdog The external watchdog has lost If this alarm appears return
Timer Reset communication with the pump. pump for service.

This means there is no control
over the main processing unit of
the pump. The internal
watchdog (a CPU) then
commands the reset.

Battery Battery reached its critical In case of reoccurring alarm
Temperature temperature or exceeded it replace battery. For more
out of range (60°c). information refer to Chapter
5: Replacing the Battery on
page 154.
System System reached its critical If this alarm appears return
Temperature temperature and exited it (70°c).  pump for service.
out of range
External The external watchdog has lost If this alarm appears return
Watchdog communication with the internal  pump for service.
watchdog (CPU).
Battery Battery has depleted and canno  Replace the battery. For
Depleted longer supply sufficient powerto  more information refer to
the pump. The alarm is triggered  Chapter 5: Replacing the
by battery voltage below 6.8V. Battery on page 154.
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Alarm Title Description Solution

PME Pump Mechanism Error- Thisisa  If stated on screen, return
family of alarms related to pump to service. In all other
problems with the actual cases, the pump set up or
mechanism. battery voltage was too low;

therefore recharge the
battery and test for
reoccurrence.

If the alarm doesn't appear
again, this is not a pump

failure.
End of Battery Battery has exceeded its usage If this alarm occurs replace
Life life (has been in use for more the battery. For more

than 2 years or reached the max  information refer to Chapter
of 500 charges cycles) and needs  5: Replacing the Battery on

to be replaced with a new one. page 154.
Non-Authorized A battery that was not If this alarm occurs replace
Battery authorized by Q Core to be used  the battery. For more
with the pump. information refer to Chapter
5: Replacing the Battery on
page 154.
System Error A group of system errors. In If this alarms appears return
some cases, depends on the pump for service.

error cause, it is possible that the
error will not be written to the

Event Log.
Internal The pump has lost Disconnect and reconnect
Communication ~ communication with the battery.  the battery. In case of
Error reoccurring alarm replace
battery. For more
information refer to Chapter
5: Replacing the Battery on
page 154.
External The pump CPU has lost In case of reoccurrence
Communication ~ communication with the LCM return pump for service.
Error (Liquid Crystal Module) or the
LCM lost communication with
the CPU.
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Alarm Title

Air in Line

Description

An air bubble, bigger or equal
by size to the value defined by
user was detected by the light
sensor.

Excessive environmental light, in
addition to the regular Airin Line
conditions, was detected

Accumulated The accumulated bubble volume

Airin line has reached its limit (set by user)
in 15 min (only bubbles that are
bigger or equal by size to the
user set value are counted).

Downstream/ Downstream

Upstream occlusion-Occlusions from the

Occlusion pump to the patient line.
Upstream occlusion- Occlusions
from the reservoir/bag to the
pump.

Possible An infusion was started with

Occlusion clamps closed. Not a pump
malfunction.

Unknown There is an occlusion but the

Occlusion pump is not able to determine if
it is upstream or downstream.
Alarm in normal course of
operation.

Check for This alarm occurs when an

Occlusion occlusion, either downstream or

upstream, is detected at the
beginning of treatment, while
the pump is determining a
reference.
AS not loaded/
misplaced

Administration Cassette is not
loaded successfully if at all.
Alarm in normal course of
operation.

Sapphire & SapphireH100

Solution

Normal course of operation.
Not a pump malfunction.

Normal course of operation.
Not a pump malfunction

Normal course of operation.
Not a pump malfunction.

Normal course of operation.
Not a pump malfunction.

Normal course of operation.
Not a pump malfunction.

Normal course of operation.
Not a pump malfunction.

Normal course of operation.
Not a pump malfunction.

Normal course of operation.
Not a pump malfunction.
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Alarm Title

Low voltage for
current rate

Inconsistent
flow

Air detector
Faulty

Incorrect
pressure value
reading

30 min to
battery
depletion

Treatment
complete

Door opened

Pump
unattended

Treatment near
end

Charge error

Battery life
expires 2 days

199

Description

Detected when the pump cannot
reach a current rate due to
reaching PWM 140 when battery
power is insufficient. Happens
only when the pump is on
battery power.

Alarming when pump is not
running in a stable flow rate.

The air detector is unable to
make correct readings.

User has at least 30 min of pump
use in current rate before the
battery is depleted and pump is
turned off.

Treatment is complete, VTBI is
fully infused.

The administration set door is
opened or not fully closed.

The pump has been idle for the
set amount of time.

There are <xx> minutes before
the end of treatment.

It is taking longer than usual to
charge the pump. Alarm is
triggered after 7 hours of charge
time.

In 2 days the battery will reach its
two years life time.

Solution

When pump is working on
battery: Alarm in normal
course of operation. Not a
pump malfunction.

If this alarm appears return
pump for service.

Clean the air detector. If
reoccurring alarm return
pump to service.

If this alarm appears, return
pump for service.

Normal course of operation.
Not a pump malfunction.

Normal course of operation.
Not a pump malfunction.

Normal course of operation.
Not a pump malfunction.

Normal course of operation.
Not a pump malfunction.

Normal course of operation.
Not a pump malfunction.

In case of reoccurring alarm
replace charger and battery.
If the alarm is periodically
reoccurring, send pump for
service.

Replace the battery. For
more information refer to
Chapter 5: Replacing the
Battery on page 154.
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Alarm Title Description Solution

Calibration Due ~ Working time or calendar time Perform Annual

now” has ended. Calibration may be Certification.
needed.

Calibration Due  Working time or calendar time Perform Annual

2 days” has ended and is due in 2 days.  Certification.
Calibration may be needed.

Calibration Due ~ Working time or calendar time Perform Annual

2 weeks” has ended and is due in 2 weeks.  Certification.

Calibration may be needed.

" n Sapphire Multi-therapy and Sapphire Epidural Rev. 15 these messages are not
displayed

Upgrading Software Version

The following sections explain how to upgrade the software version in the

Sapphire pump:
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Troubleshooting Software Upgrade ........cccoeeeeiiiiiiiiiiiiiieceeeeeceee e, 211
Overview

New software revisions are downloaded to the pump using Q Core’s Pump
Loader software. The Pump Loader Software is a tool used to download new
software revision (Revision) to the pump. Both the Pump Loader and Revision
can be obtained from Q Core FTP site (https//qcore.smartfile.com). For
information regarding the FTP site, refer to FTP site on page 32.
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The current software version of the pump can be viewed using the Options
menu.

> To view the current software version:
1. From the Options menu, select View - View System.

2. On the toolbar, press Next until the Software Version parameter is

displayed.

A A software update may erase some of the pump settings. It
is recommended to keep a copy of the pump’s current
settings for your records before updating the pump software
version.

Prerequisites

Before beginning the upgrade process, verify that the following hardware and
software requirements are met.

Hardware Requirements

e PC: Pentium 4, 1500MHz CPU, 512 RAM (or higher)
e  Screen resolution 1280x1024 (minimum)
®  Communication cable for the Sapphire pump (P/N 05020-110-0213)
e RS232 connectivity in either of the following forms:
® RS232 port in the computer

Figure 6.5. PC Connector

® USB to RS232 adaptor + driver (P/N 15077-000-0001)
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Figure 6.6. USB Adaptor and Driver

° Internet connection.

Software Requirements
e OS: Win XP 32/ 64 bit, Win 7 32/64 bit, Win 8.1 32/64 bit, Win 10 64
bit
® _.Net framework 4.0
® WinRar or other software for handling .zip files
® Pump Loader software (.rar file provided by Q Core)
* Sapphire Pump Revision software (.qmf file provided by Q Core)

Upgrade Procedure

Use the most updated version of the Pump Loader. The most updated version
of the Pump Loader can be found on the Q Core Medical FTP site (https://
qgcore.smartfile.com/).

The Pump Loader is compatible with all approved pump software revisions.

SapphirePlus pump software can be updated using the Pump Loader software
or using the Wi-Fi connection (see the Chapter 7: SapphirePlus on page 222).

Up to 8 Pump Loader instances can be used simultaneously on one computer.

The Pump Loader requires communication with the Q Core Medical server. In
case of communication problems refer to Troubleshooting Software Upgrade on
page 211.
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Informing Q Core Medical on Pump Software Update

For SapphirePlus pumps, if the Wi-Fi is used (MedNet) for the software
update, it is required to fill in and submit the Pump Software Update Using
MedNet form (15038-049-0001) as provided on the Service Portal. This form
should be submitted electronically (soft copy) to service@qgcore.com.

o ® |n software versions that support disabling of the Air
detection, to maintain the air detector settings values fol-
lowing software update, set the Air Detection setting to
On prior to the software update. If the Air Detection
setting is set to Off, following software update the air
detector settings are set to factory defaults.

® Following the pump's software update additional pump
settings may be added (according to the software
updated). If additional settings are added they are set to
factory defaults.

® Following the pump's software update, the Occlusion
Alarm setting value configured on the pump may
change. To maintain pump configuration, record the
Occlusion Alarm value before the pump software
update. After the software update has completed, config-
ure the pump with the original Occlusion Alarm value.

> To install the Pump Loader software:

1. Download the setup file Pump Loader Setup (.msi or .exe file) from the
Q Core Medical FTP site to a directory of your choice.

2. Double-click the Pump Loader Setup file to start the installation process
and click Next.

3. Review the license agreement details and check the relevant checkbox to
accept.

4. Itis possible to create shortcuts to the Pump Loader software; Check/
uncheck the relevant checkbox, as desired.

5. Click Install.

After the installation has completed, click Finish.
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Prior to starting the software update

Prior to starting the software update process perform the following:

1.

Connect the pump to the power supply. Otherwise, verify the pump's
battery is fully charged.

If using the USB-to-RS232 adaptor, verify that the adaptor driver is
installed on the computer prior to connecting the pump to the computer.

Verify that the software to be updated on the pump is compatible with
the pump according to latest Labeling and Software Revision Table,
15000-004-0002-SM or Labeling & SW Revisions Table for Q Core Service
Providers, 15000-004-0003-SM. Make sure you select the software
designated for each pump type.

For example, do not install All modes software designated for Multi
Therapy pumps on an Epidural pump (yellow lexan).

All modes software: installed on Sapphire Multi-Therapy pumps ONLY
Epidural only software: installed on Sapphire Epidural pumps

SapphireH100 software: installed on SapphireH100 pumps
SapphirePlus software: installed on SapphirePlus pumps

Verify the computer is connected to the internet.

Disable the sleep mode on the computer; failing to do so may result in
update failure.

Software Update Process

> To update the software:

1.

Turn the pump on. Connect the pump to the computer using the
communication cable. You may also use the USB-to-R5232 adaptor.

Open the Pump Loader software by double-clicking the Pump Loader
icon.

The window Pump Loader Login opens.
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Figure 6.7. Pump Loader Login Prompt
f B Q-Core Pumploader - Login M‘

User name |

Password |

3. Enter the credentials; then, click Login.

o The credentials to the Pump loader software are the same
on all Sapphire PC tools.

The credentials are retained as long as you remain logged in
to the Windows account. You will not be prompted to log in
again, as long as you remain logged in to the Windows
account.
In case the software is installed on a computer that is used
by different personnel in your facility, please remember to
log off, or lock your Windows account to prevent the use of
the Pump Loader SW by uncertified personal, using your
credentials.

4. The window Pump Loader Communication Ports opens. Select the
suitable COM port, and then click OK.
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Figure 6.8. Pump Loader Communication Ports Window

Pump Loader Cumrmn'ﬂ!' n Po_éﬂg

FPlease select one of the available ports:

USE Serial Port (COM3)

USE Serial Port (COM10)

USB Serial Port (COM11)

USB Serial Part (COM12)

Intel(R) Active Management Technology - SOL (COM4)

[ Ok ][ Cancel ]

5. The main screen of the Pump Loader appears. After a few seconds the
Status field should indicate Pump connected. If the status field indicates

No device connected verify that the pump is connected properly to the
computer via the correct COM port.

In case of communication problems refer to Troubleshooting Software
Upgrade on page 211.

The main screen of the Pump Loader includes the following fields (see
figure below):
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Figure 6.9.

Pump Loader Screen

.
B - [Pump Loader - No Device, Port - Rs232: Com36, Baud:d... e

File Help

Status:

No device connected

Pump SN: Pump SW Version:

Gther - browse. . ~]

Package File: imm Selected

| |

Overall progress: 0%

Progress

No| Sts| Description

Ready

Field Name Function

File menu The Exit option is used to exit the Pump Loader

Help menu Includes the options Show Instructions (Hide Instructions
after Show is selected) and About. The Show Instructions
option shortly explains how to upload software on the
pump. The About option displays the Pump Loader
version information.

Status Indicates if the pump is connected to the computer and
the status of the upload process

Pump SN Displays the serial number of the pump

Pump SW Displays the current software version of the pump

Version

Load button Allows the selection of the software to upload to the
pump

Package File Displays the software that is being uploaded to the pump
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Field Name Function

Two progress Indicating the progress of the upload. The bottom

bars progress bar indicates the status of the overall progress

Progress A table displaying the actions performed by the Pump
Loader

6. Click Load. Select the software to upload to the pump by double-clicking
on the software file. The upload will start automatically.

o Do not turn the pump off or disconnect it from the computer
while the update is in progress.

/. The pump software update is completed when a message The update
was completed successfully is displayed on the computer and on the
pump. See Figure 6.10.

o Do not disconnect the pump from the computer before the s
of successful update appear both on the computer and on
the pump. Pay attention to the relevant COM port.
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Figure 6.10.  Software update completed

8.

10.

B - [Pump Loader - Com34 - Pump 300203582] = = |
File Help
Ingtalifion Complte Installation
- Successful
Pump Loader - Com34 - Pump 300203582 ﬂ‘
@ Installstion Successful Com 3
e e To return to Start Up screen,
disconnect pump from PC.
This may take several seconds.

Computer Screen Pump Screen

After the software update has completed, press OK on the computer,
close the Pump Loader and disconnect the pump from the computer.
Wait until the "Installation Successful" screen has disappeared and the
pump has returned to the Start Up screen. Restart the pump.

If the pump software language is not as required, refer to the Defining
Regional Parameters section on page 170.

Verify that the desired software was uploaded on the pump. On the
pump, go to: Options = View = View system. Click Next until the
Software version field is displayed. Verify that the software version
displayed matches the pump type, refer to the SW Revisions Table for

Q Core Service Providers, 15000-004-0003-SM or Labeling and Software
Revision Table, 15000-004-0002-SM.

o In any case that the software was not updated successfully it
is required to close the Pump Loader, restart it and repeat
the software update process.
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After verifying that the software was uploaded successfully, change the mL/h
only setting: if it is set to On change it to Off; If it is set to Off change it to On:

1. Enter the menu: Options - Technician options » Pump settings -
General. Press Next.

2. Toggle the mL/h only setting as described above.

o Only relevant when upgrading from Rev. 11 to Rev. 13, or
fro